This is the best Grade 11 Computer Applications Technology study guide you will ever have!

Here are some tips to make this a good year.

Remember, good learning begins in the classroom!

Always:
- listen and concentrate
- observe: watch carefully what is happening
- make notes to help you remember what you are learning
- ask questions to make sure you understand.

Study tips
- Allocate one hour every week-night as study time in addition to your homework.
- Decide when your main study time should be. Some learners study better in the early morning, some study better in the evening.
- Keep to your timetable.
- Study time is a priority – it is one of the most important things in your life at school.
- Find a quiet place to study. (Try a quiet classroom at school or the local library if possible.)
- Choose study partners who are serious about doing well to work with you.

7 golden rules for success
1. Always do your homework.
2. Do not fall behind.
3. Study every day.
4. Eat healthy food and sleep at least eight hours each night.
5. Make sure you understand as you go along.
6. Do it now!
7. Do not give up: learning gets easier and faster when you practise.

Good luck!

The authors
Contents

Welcome Via Afrika Computer Applications Technology Grade 11 ii

Chapter 1 Systems technologies 1
  Unit 1 General concepts (Term 1) 2
  Unit 2 Hardware (Term 1) 5
  Unit 3 Hardware (continued) (Term 2) 10
  Unit 4 Software (Term 3) 13
  Unit 5 Hardware, software and computer management (Term 3) 15

Chapter 2 Network technologies 16
  Unit 1 Networks (Term 2) 17

Chapter 3 Internet technologies 22
  Unit 1 The WWW (Term 2) 23
  Unit 2 The Internet, WWW and communication (Term 3) 26
  Unit 3 Managing e-mail (Term 4) 31

Chapter 4 Word processing 33
  Unit 1 Formatting and customising documents (Term 1) 34
  Unit 2 Applying styles (Term 2) 43
  Unit 3 Mail merge and references (Term 3) 44
  Unit 4 Mail merge and integration (Term 4) 48

Chapter 5 Spreadsheets 50
  Unit 1 Formatting, formulas and functions (Term 1) 51
  Unit 2 IF function, charts and integration (Term 2) 54
  Unit 3 Work with and share spreadsheets (Term 3) 56
  Unit 4 Solving problems with spreadsheets (Term 4) 59

Chapter 6 Databases 62
  Unit 1 Database concepts and basic skills (Term 1) 63
  Unit 2 Table design and Queries (Term 2) 69
  Unit 3 Reports and external data (Term 3) 73
  Unit 4 Integration and problem solving (Term 4) 75

Chapter 7 HTML and web design 80
  Unit 1 Introduction to HTML (Term 2) 81
  Unit 2 Web design and more HTML (Term 3) 86

Chapter 8 Information management and PAT 93
  Unit 1 Gathering and managing information (Term 2) 94
  Unit 2 Processing information (Term 3) 97
  Unit 3 Presenting information (Term 4) 99

Exams Papers and Memorandums 103
  Practical Examination – Paper 1 103
  Theoretical Examination – Paper 2 109
  Practical Examination – Paper 1 Memorandum 118
  Theoretical Examination – Paper 2 Memorandum 121

© Copyright Via Afrika Publishers, Computer Applications Technology Grade 11
Chapter 1  System technologies

Overview

To get the most out of this chapter, you need to be familiar with the hardware and software concepts that were covered in Grade 10. In this chapter, you will learn about general concepts of computing: hardware input and output devices; hardware storage devices and processing procedures; software and software management; and basic computer management.
1 Information processing cycle
- The information processing cycle consists of input, processing, output and storage.
  - Input is data being entered into a computing device using an input device.
  - Processing is when data is being translated into something useful by the CPU and RAM.
  - Output is when information is presented to the user after processing.
  - Information and data can be stored for future use.
- Computers can communicate data and information using a communication network.

2 Types of computers and typical features

2.1 Dedicated computers
- Dedicated computers are designed to perform a specific task rather than for general use.
- Examples include ATMs, washing machines and MP3 players.
- Computers housed in appliances or other equipment are called embedded computers.

2.2 Mobile computers and devices
- Mobile computers are designed to be easily portable.
- Mobile devices include PDAs, laptops and smart phones.
- A PDA (Personal Digital Assistant) is a small touch screen device that acts as an electronic diary.
- PDAs are primarily used for appointments and reading documents.
- A smart phone is a cellular phone with functions and features normally found on computers.
- PDA features include:
  - ability to run third-party software
  - an up-to-date operating system, such as Android or Symbian
  - greater processing power than cell phones
  - more storage space than a cell phone or PDA
  - programmability
  - e-mail facilities.
- Laptop computers have the same features and functions as desktop computers, but are designed to be mobile. Features include:
  - smaller size than desktop computers
  - input and output devices are integrated into the unit
  - ability to run from battery power, as well as a power outlet.
- A tablet computer uses a touch screen interface.
- A virtual keyboard is used instead of an actual physical keyboard.
- A tablet computer can accept handwritten notes and speech input.

2.3 Client/server
- This is a shortened way of saying client/server network.
- Computers that provide resources on a network are called servers.
- Computers that use resources on a network are called clients.
3 Computer categories

3.1 Portable and non-portable computers
- Portable computers include computing devices designed to be easily portable.
- Non-portable computers are designed to remain in one place.

3.2 Usage
- Computers can be categorised according to the way they are used, such as:
  - education
  - business use
  - personal use
  - industrial use.

3.3 Processing power
- A CPU sends out electrical pulses to synchronise components.
- The number of pulses governs the speed of the computer.
- CPU speed is based on the amount of instructions it can complete in a second.

Personal computers
- Personal computers are used for home and business use.
- CPUs can have multiple cores, such as a dual core or quad core machine.

Mainframes
- Mainframes are designed to handle large amounts of data reliably.
- Mainframes can store huge amounts of data.

Supercomputers
- Supercomputers are the most powerful computers available.
- They are used for resource intensive tasks, such as weather forecasting.

4 The role of ICT in the workplace

4.1 Education and training
- Computers can adapt to the speed of the learner
- Lecturers and learners can communicate over any distance
- Demand for skilled workers in ICT has gone up

4.2 Communication
- Networks allow communication between workers.
- E-mail and video conferencing are more efficient than travelling.

4.3 Careers
- Computer technology enabled the building of robots.
- Robots can work in places where humans cannot, such as:
  - explore remote areas, such as the moon
  - explore dangerous places
- defuse bombs in urban areas
- work in toxic areas
- perform menial work.

Knowledge and skills learnt in CAT can be used in ICT careers, such as:
- communication technician
- management of computers
- training workers in the use of ICT
- computer technician
- web designer.

5 Social issues related to the use of hardware and software

5.1 Hardware theft and protection
- Laptops can be fastened to a fixture using a Kensington lock.
- Desktop computers can be bolted to the floor or desk.
- Security guards, burglar bars, locking doors and biometric security can be used to secure computers
- Servers should be kept in a separate locked room.
- Backups should be kept off-site.

5.2 Power saving
- Power can be saved on your computer by:
  - switching of your computer when not in use
  - using energy efficient hardware
  - switching off any peripheral devices, such as printers, when not in use
  - using a UPS (uninterruptible power supply) provides a computer with a constant power supply if the power is cut off.
- Surge protectors are used to prevent damage to electronic equipment because of power spikes.

5.3 Health and health risks
- To reduce health risks:
  - use ergonomically designed furniture
  - take regular breaks
  - look away from the screen every 30–40 minutes
  - sit comfortably with a good posture
  - use an ergonomically designed keyboard with wrist rest
  - work in a well lit and ventilated room.
Unit 2 Hardware (Term 1)

1 Input
- Input is any data or instructions entered into a computer.
- Instructions can include:
  - user commands
  - application software or utilities that a computer must run
  - trigger events from monitoring devices.

1.1 Scanners
Scanners are used to convert hard copies of images or documents to soft copies.

<table>
<thead>
<tr>
<th>Advantages and disadvantages of scanners</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Advantages</td>
<td>Disadvantages</td>
</tr>
<tr>
<td>Images can be transferred to a computer and e-mailed.</td>
<td>High quality scans can take up a lot of storage space.</td>
</tr>
<tr>
<td>A scanner and a printer can be used together to make copies.</td>
<td>Scanner needs to be of a high quality to create high quality scans.</td>
</tr>
</tbody>
</table>

1.2 Digital cameras
Digital cameras are used to record images using a sensor and store the images on a memory card.

<table>
<thead>
<tr>
<th>Advantages and disadvantages of digital camera</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Advantages</td>
<td>Disadvantages</td>
</tr>
<tr>
<td>Image can be seen immediately. Images that are not wanted can be deleted.</td>
<td>The initial cost of buying a digital camera can be much more expensive than a film camera.</td>
</tr>
<tr>
<td>Images can be downloaded to your computer.</td>
<td>Moisture is a possible problem, because of all the electronic components.</td>
</tr>
<tr>
<td>Images do not have to be developed.</td>
<td></td>
</tr>
<tr>
<td>You only print the images that you want, which is cheaper.</td>
<td></td>
</tr>
<tr>
<td>A memory card can hold more photos than a film.</td>
<td></td>
</tr>
<tr>
<td>The memory card can be erased and used again.</td>
<td></td>
</tr>
<tr>
<td>Most digital cameras can also record digital video.</td>
<td></td>
</tr>
</tbody>
</table>

1.3 Biometric input
- Biometric input uses unique features of a person to identify them.
- Features used for biometric input include:
  - fingerprints
  - voice recognition
  - facial recognition
  - iris recognition
  - retina scanners
  - signature verification
### Limitations of biometric input as a security measure

<table>
<thead>
<tr>
<th>Biometric input</th>
<th>Limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice recognition</td>
<td>Will not work for mute people, or people who have a speech impediment</td>
</tr>
<tr>
<td></td>
<td>Disease, sickness or injury to the lungs, throat or mouth may change your voice pattern.</td>
</tr>
<tr>
<td>Fingerprint or handprint recognition</td>
<td>Will not work for people that do not have hands.</td>
</tr>
<tr>
<td></td>
<td>Will not work for children, because their fingerprints grow as their hands grow.</td>
</tr>
<tr>
<td></td>
<td>Injury to the hand, such as cuts or burns, may prevent recognition.</td>
</tr>
<tr>
<td>Facial recognition, iris and retina scanners</td>
<td>Does not work well in poor light</td>
</tr>
</tbody>
</table>

### Advantages and disadvantages of biometric input

<table>
<thead>
<tr>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is no need to worry about forgetting your password.</td>
<td>Voice activated locks will not work if you have the flu, because it affects your voice.</td>
</tr>
<tr>
<td>Your password cannot be guessed by other users.</td>
<td>Diabetes affects your eyes, which will result in an inaccurate iris scan.</td>
</tr>
<tr>
<td>Your biometric feature is unique.</td>
<td>Devices used for biometric security are extremely expensive.</td>
</tr>
<tr>
<td>The administrator does not need to reset your password.</td>
<td>Cuts or burns to your hands or fingers may result in identification not working.</td>
</tr>
<tr>
<td>Biometric identification leaves no doubt as to the identity of the user.</td>
<td></td>
</tr>
</tbody>
</table>

#### 1.4 Input via mobile devices
- Smart phones and PDAs can be used as data collection devices.
- Data can be sent or retrieved from a central point.

### Advantages and disadvantages of input via mobile devices

<table>
<thead>
<tr>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile devices are easy to carry around.</td>
<td>Many mobile devices are quite expensive.</td>
</tr>
<tr>
<td>Devices can be connected wirelessly.</td>
<td>Devices have small screens making input difficult.</td>
</tr>
<tr>
<td></td>
<td>Software available for mobile devices is still limited.</td>
</tr>
</tbody>
</table>

#### 1.5 Terminals (POS) and ATMs
- Terminals rely on servers or mainframes to perform the processing.
- POS (Point-of-sale) terminals usually consist of a screen, keyboard, scanner and cash drawer.
- ATM terminals are used to withdraw cash from a bank account.
1.6 Touch screens
Touch screens allow users to interact with images on the screen by touching the screen.

<table>
<thead>
<tr>
<th>Advantages and disadvantages of touch screen input</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advantages</strong></td>
</tr>
<tr>
<td>The device can be very small, because it does not need a physical keyboard of pointing device.</td>
</tr>
<tr>
<td>Use of touch screens is easy and intuitive. Simply touch the screen to select options.</td>
</tr>
<tr>
<td>Keyboard layout can be changed on the screen.</td>
</tr>
<tr>
<td>A larger display area means icons can be large, making them easy to see and use.</td>
</tr>
</tbody>
</table>

1.8 Wireless technology

<table>
<thead>
<tr>
<th>Comparison of Bluetooth and infrared connectivity</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bluetooth</strong></td>
</tr>
<tr>
<td>Speed</td>
</tr>
<tr>
<td>Line of sight</td>
</tr>
<tr>
<td>Range</td>
</tr>
</tbody>
</table>

2 Output
- Output is information or data that a computer produces after processing.
- Output devices are hardware components that convey information to a user, such as a monitor or printer.

2.1 Advantages and disadvantages of output devices

Interactive whiteboard
- It is a touch-sensitive device, which works by projecting an image using a data projector.
- The presenter can control the display by touching the projected image.
- A computer can also be controlled via a remote or digital pen.
- A virtual keyboard can be used instead of a physical keyboard, so a user does not have to sit behind the computer.

Monitors
- Resolution is the amount of pixels that can be displayed on a monitor.
- A higher resolution will result in a crisper, more detailed image.
- Colour depth is the number of colours that can be shown on the monitor.

Printers
- The quality of a printout is measured in dpi (dots per inch).
- Higher dpi values will result in a higher quality printout.
2.2 Wireless technology
Output devices can be connected wirelessly using Bluetooth or Wi-Fi.

3 Other input and output requirements
3.1 Device drivers
- Device drivers are small programs designed to aid communication between hardware devices and the operating system.
- Drivers can be obtained from:
  - CD/DVD that came with the hardware device
  - manufacturers website
  - third-party websites.
- Some devices, such as smart phones, have device drivers stored on a ROM chip within the device.

3.2 Optical character recognition (OCR)
- OCR is used in conjunction with a scanner.
- The program reads and converts text from a scanned document.

3.3 Stylus
- It is a pen-like device with a plastic tip.
- It is used as a pointing device on a touch screen.

4 Software and devices for physically challenged users
4.1 Enhancing accessibility
- Accessibility options range from software settings to new hardware devices.
- Accessibility options are designed to help physically disabled people in using a computer.

Text to speech combined with speakers
- Text to speech software converts text to a computer-generated voice.
- Speech recognition is used to converted voice to text.
- Speech recognition can also be used to give verbal instructions.

Screen settings
- Screen settings to enhance accessibility include:
  - lower screen resolution to enlarge icons
  - using a high contrast theme
  - changing the thickness of the cursor
  - using visual cues instead of audible alerts.

Joystick instead of a mouse
- A joystick is a lever that a user can use to move the cursor instead of a mouse
- It is widely used for flight simulators.
- Paraplegics use a small joystick in their mouth that they can move with their tongue.
**Alternative keyboards**

- Alternative keyboards include:
  - a virtual keyboard or an onscreen keyboard
  - a keyboard with large buttons
  - a keyboard with a special wrist rest
  - keyboards in a different configuration
  - touchless keyboards that work by resting a laser on a light sensitive keyboard.

**Mouse and keyboard settings**

- Mouse settings to aid accessibility include:
  - mouse buttons can be swapped for left-handed users
  - enlarging the mouse pointer on the screen
  - enabling keys on the keyboard to move the cursor
  - slowing down the double click speed.

**Keyboard settings include:**

- Sticky keys, which allow users to press buttons sequentially, instead of together.
- Sounds assigned to certain keys.
- Keys that are pressed more than once in rapid succession can be ignored.
- To access keyboard and mouse settings, open the Control Panel and select keyboard or mouse.

**Screen readers and screen magnifiers**

- A screen reader is a program that recognises actions being performed on the screen.
- It uses a computer-generated voice to tell a user what is happening on the screen.
- Screen magnifiers enlarge the section of the screen where the cursor is currently located.
1 Storage
Storage is the process where data or instructions can be kept on the computer permanently or temporarily.

1.1 Primary storage and secondary storage
- Primary storage is temporary storage for data being currently used by the CPU.
- Primary storage is referred to as memory or RAM.
- Secondary storage is permanent storage.
- Examples of storage include hard drives, CD/DVD media and flash drives.
- RAM is:
  - volatile, meaning it needs electricity to keep data stored
  - electronic.
  - It is much faster than secondary memory.
  - Secondary memory is non-volatile.

1.2 Online storage
- Online storage is also referred to as cloud storage.
- It is the process of storing data or information on file servers connected to the Internet.

<table>
<thead>
<tr>
<th>Advantages and disadvantages of online storage</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advantages</strong></td>
<td><strong>Disadvantages</strong></td>
</tr>
<tr>
<td>Data can be accessed from anywhere in the world where the Internet is available.</td>
<td>Need to be connected to the Internet to retrieve the data.</td>
</tr>
<tr>
<td>Storage on your own computer is not being used.</td>
<td>Usually a cost involved, in a foreign currency.</td>
</tr>
<tr>
<td>Audio, video and graphics files can be stored or retrieved immediately from the Internet.</td>
<td></td>
</tr>
<tr>
<td>Other users can access the files from a link instead of e-mailing the whole file.</td>
<td>Data security is a potential problem. Questions about ownership of the data and access rights to the data may or may not be denied.</td>
</tr>
<tr>
<td>Where time is critical data can be retrieved immediately.</td>
<td></td>
</tr>
</tbody>
</table>

1.3 Suitable storage media for backup
Backups are duplicate copies of important data, kept on a separate storage device.

Optical media
- Optical disks are flat plastic disks onto which data is stored and later retrieved by lasers.
- Examples include CDs and DVDs.

Flash drives
- They are small, portable electronic storage devices.
- They connect to a computer via a USB port.
Removable or external hard drives
- They are also known as external hard drives.
- They are used when large storage space is needed.

1.4 How to write CDs and DVDs:
- Select files/folders to be written to CD or DVD.
- Right click and select copy.
- Open My Computer and select the drive containing the blank CD/DVD.
- Right click and then select paste.
- Select the drives icon, right click and select Write files to CD.

2 Overview and basic concepts of start-up
The sequence of events when a computer is switched on is called the start-up process or boot-up process.

2.1 Power-on self-test (POST)
- It checks whether all components are receiving the correct amount of power.
- The BIOS is started if all POST-tests have been completed.

2.2 Basic Input Output System (BIOS):
- Set of instructions saved on a ROM chip.
- BIOS checks to see which devices should be found on the computer.
- Sets the current time and date.
- Confirms the amount of RAM.
- Checks for devices used for permanent storage.
- Checks whether the keyboard and mouse are present.
- Determines which device will be used for the boot-up process.

2.3 Booting the operating system
- Certain files are stored in a section of the hard drive and known as the bootstrap loader.
- All files needed by the OS are now loaded.

3 Processing
- A computer takes data and creates output in the form of information.
- The motherboard, CPU, RAM and ROM are involved in processing.

3.1 Functions of a computer's basic components

Motherboard
The motherboard is the main circuit board of the computer and connects all components within the computer.
Central processing unit (CPU)
- The CPU controls every event within the computer.
- Its speed is measured in GHz.
- CPUs are available as multi-core CPUs, such as dual-core and quad-core CPUs.

Random access memory (RAM)
RAM is used as temporary storage of data and instructions being used by the CPU.

Read only memory (ROM)
ROM is non-volatile memory used to store instructions or programs needed by hardware devices permanently.

3.2 Interpret advertisements:
- Distinguish between different types of hardware and software.
- RAM is primary memory and measure in MB or GB.
- CPU is rated in MHz.
- Secondary storage includes hard drives and measured in GB.
- The operating system controls the computer.
- CD writer is not needed if a DVD writer is present.

3.3 Basic troubleshooting
- Troubleshooting is a process where information about a problem is gathered and then solved in a step-by-step fashion.
- Trouble shooting can be done by:
  - root-cause analysis
  - using an expert system
  - process of elimination.
Unit 4 Software (Term 3)

1 Application software
Application software is designed to help users perform specific tasks.

1.1 The role of application software
- Examples of application software include:
  - accounting system software
  - payroll software
  - office suites
  - asset management
  - point-of-sale software.

1.2 Multimedia and communication software
- Multimedia applications use more than one medium to communicate with a user.
- It can include text, images, audio and video.
- Communication software is used for Internet access, browsing, e-mail, Internet telephony calls and video conferences.

1.3 Compatibility issues
- Application software is designed to work on specific operating systems.
- Application software also needs specific hardware to work.
- If specific hardware or software is not present, the application will not function.

1.4 Versions, patches and service packs
- Problems in applications are called software bugs.
- Small updates published to fix software bugs are called patches.
- Service packs include all patches and updates released up to a point.
- When applications are updated and new features are added the new release is called a new version.

1.5 Updating software
- Can be updated using an online update and an offline update.
- On-line updates are done from the Internet.
- Off-line updates are downloaded or received on a storage medium and installed.

1.6 Online applications
- Applications hosted on websites are called online applications.
- No application install is needed.

1.7 Software for physically challenged users
Software that is used to aid accessibility using specific software.
1.8 Exploring web applications: Blogs

- A blog is a web log.
- It can be in the form of a personal online diary.
- New posts are made and published in chronological order.

Uses
Blogs can be used as a personal diary, advertising new products, special interests, such as a chess club.

Advantages and disadvantages of blogs:
- Everybody can offer their opinion.
- Wide variety of readers around the world.
- Some blogs are vague and difficult to read.
- Not everyone can write good enough to be interesting.

Good practices:
- Readers must be interested and come back to read more.
- Blogs must be updated regularly.
- Post must be kept short.
Unit 5 Hardware, software and computer management (Term 3)

1 Basic system requirements
- Applications need a minimum set of hardware and software to function called the minimum system requirements:
  - enough space on the hard drive
  - CPU speed needs to be able to run at a specific speed
  - enough RAM is needed.

2 Software installation
Software installation is the process of copying files and folders to the hard drive from a portable medium, and shortcuts are added.

2.1 Portable storage medium
Used for installing an application from a portable device, such as a flash drive or a CD/DVD.

2.2 Internet download
- Applications are downloaded from the Internet as an executable file or compressed file.
- Compressed files need to be uncompressed first and then installed.

3 Management of files
3.1 File types
- Files and folders are shown on the screen as icons.
- Each application has a different icon.

3.2 File attributes
- Read-only – files cannot be edited.
- Hidden – files cannot be seen.
- Archive – files have been marked as still to be backed up.

3.3 Import and export
Moving data from one computer application to another application.

3.4 Search
- The search function is used to search for specific files or folders on a computer.
- Search can include file names, size of the file and contents of a file.
This chapter gives an overview of the components and concepts of a network and compares wireless and wired local area networks. Among the aspects of networks covered are network security, definition of an Intranet and data transmission speeds.

In this chapter you will learn about local area networks, both LAN and WLAN; the basic components of a network; network connection types and speeds; definition and uses of an intranet; and basic network security.
Unit 1 Networks (Term 2)

1 LANs and WLANs

- A computer network is a system of two or more computers or computing devices connected to each other.
- A computing device is any device with computing qualities.
- Device are connected using a communications channel/medium.

1.1 Definition and purpose

- A LAN covers a small area, such as a room or building. The largest LAN is a campus.
- A WLAN is a LAN that is connected wirelessly

1.2 Advantages, disadvantages and limitations:

- Facilitating communications – communication is much easier.
- Sharing devices – expensive devices, such as printers, can be shared.
- Centralised storage – all data is stored in one central place.
- Data transfer – easy to transfer without other storage devices.
- Increased security – security rights can restrict access to software and data.
- Installing and updating software – software can be installed from one central point.
- Easier backup – central point makes backup easy.

Advantages of WLANs include:

- users can connect from places where cables are difficult to install
- mobile computing devices can be moved and stay connected.

Disadvantages and limitations of a LAN include:

- initial installation cost is expensive
- installing and maintaining a LAN is time consuming
- viruses can spread quickly
- because computers are interconnected, security breaches may occur
- speed on a LAN is limited by the communications channel
- connections on a WLAN may be dropped periodically.

2 Basic components of a network

2.1 Workstations and servers

- Workstations are computers that users will work on.
- Servers are powerful computers that provide specialised functions on a network.
- Examples of servers include:
  - file servers
  - print servers
  - web servers
  - proxy servers.

2.2 Communication medium

A communication medium transfers data from one point to another in a network.
**Twisted pair cabling**
- Insulated copper wires wound together in pairs
- Pairs are grouped and inserted in a protective sleeve
- Uses an RJ45 connector

**Coaxial cabling**
- An insulated copper core
- Conductive metal mesh around the insulation, with an additional insulation around it
- Usually used for TVs, satellite decoders or an antenna

**Fibre optic cable**
- Uses fine strands of glass or plastic fibre bundled together and insulated
- Uses light pulses to transfer data instead of electricity
- Expensive to buy and difficult to install

**Wireless**
Advantages of Wi-Fi include:
- no need to install cables to every room
- devices can be moved without being limited by cables
- signals can travel through walls.

**2.3 Network interface card**
- This is the physical connection between a computing device and the communication channel.
- Some devices may have built-in NICs.

**2.4 Network devices for connection**

**Router**
- Routers connect networks together.
- Routers used to connect to an ADSL line.

**Firewall**
A firewall is hardware, software or a combination thereof that prevents unauthorised access to or from a network or computer.

**Switch**
- It acts as a central wiring point in a network.
- All computers on a network will communicate through the switch.

**2.5 Network software**
To utilise a network you need a network operating system.
3 Connections

3.1 Wired and wireless networks compared

<table>
<thead>
<tr>
<th>Wired</th>
<th>Wireless</th>
</tr>
</thead>
<tbody>
<tr>
<td>Easier to install</td>
<td>More difficult to install</td>
</tr>
<tr>
<td>Better security, because a physical connection is needed</td>
<td>Security less effective if not managed correctly</td>
</tr>
<tr>
<td>Reliable connections</td>
<td>Connections dropped easily</td>
</tr>
<tr>
<td>Speed depends on the type of cable</td>
<td>Speed is usually slower than wired</td>
</tr>
<tr>
<td>Cheaper</td>
<td>More expensive</td>
</tr>
<tr>
<td>Need a physical connection point at every point you want to use the network</td>
<td>Can connect from anywhere in the signal range</td>
</tr>
</tbody>
</table>

3.2 Data transmission speed
- Data travels from one point in a network to another at this speed.
- It is measured in bits per second (bps).

4 Intranet
- This is a private network, which uses the same principles and software as the Internet.
- Uses of an intranet include:
  - hosting private websites
  - enable discussions between users/employees
  - collaboration tools
  - time and cost effective.

5 Basic network security (social implications)

5.1 Access rights
- Usernames and passwords identify users and assign security rights or access rights.
- Access rights include:
  - preventing or granting access to certain files and folders
  - prohibiting access to certain programs
  - blocking access to the internet and certain websites
  - limiting access to network servers
  - preventing users from changing system settings.

5.2 Network safety and security
- Network safety and security aims to stop unauthorised access to a network or data contained within a network.
- Security features include:
  - servers being kept in locked rooms
  - security rights updated and checked
  - use a firewall for access control.
5.3 Ethical use of networks

- Acceptable use policies will be used as a set of rules in a computer environment.
- Rules found in an AUP may include:
  - do not access information that is not your own
  - do not steal hardware on a network
  - do not try to bypass security measures on a network
  - do not access the internet for personal reasons
  - do not log into a computer system with a different username
  - treat computers with respect
  - do not install unlicensed software
  - do not insert portable storage devices without permission
  - scan all devices for viruses before using.
Questions for Chapter 2

1. Name two examples of communication channels. (2)
2. Define a LAN. (Do not just write out the abbreviation.) (2)
3. What is the major difference between a LAN and a WLAN? (1)
4. Name four advantages of connecting the computers in your school in a LAN. (4)
5. Name two types of servers you would be able to use at school. (2)
6. For each of the following statements name the type of communications cable described:
   6.1 A cable with an RJ45 connector used for LANs. (1)
   6.2 Cable used to connect an antenna or satellite dish to your television. (1)
   6.3 An expensive and difficult to install cable. (1)
7. Briefly explain the functions performed by a router and a switch in your school network. (4)
8. Define an Intranet. (2)
9. What would be your reason for using an Intranet? (1)
10. Name five items with regards to Internet usage that might be listed in your school’s AUP. (5)
11. What is the purpose of FTP? (1)
12. Describe digital communication. (3)
13. What are the differences between the web and the Internet? (2)
14. List four criteria by which you might evaluate a website. (4)
15. Write a short paragraph describing any two of the criteria named in Question 14. (4)
16. Describe, in your own words, what Internet ethics means. (2)
17. What is the difference between adware and spyware? (2)
18. Explain the difference between digital communication and communication media. (4)
19. List four types of digital communication. (4)
20. Write a short paragraph about any two types of digital communication (4)
21. List two advantages and two disadvantages of social websites. (4)
22. Discuss what 3G means and name the four services described in the standards. (5)
23. Use a table to list the advantages and disadvantages of WiMAX. (11)
24. Could you use a cell phone as a modem? (1)
25. What would you expect to find in the following e-mail folders:
   a) Inbox (2)
   b) Outbox (1)
   c) Sent Items (1)

Total marks: [70]
In this chapter you will learn about the usability of web pages and websites; types of digital communications; best practices for online services, such as banks and online shopping; use of social websites as a means of electronic communication; limitations of fixed Internet access; portable and mobile Internet access; and managing e-mail.
Unit 1  The WWW (Term 1)

1 Usability of web pages and websites
The World Wide Web (WWW) is a system of interlinked websites that are accessed via the Internet. It is important to understand that the WWW is not the same as the Internet. The WWW runs on the Internet. E-mail applications run on the Internet, as do other applications that we will look at later in this chapter. The Internet is the platform that makes the WWW possible.

The WWW is frequently referred to as the web. The web is a collection of electronic documents in the form of text, graphics, videos, audio or multimedia, which are globally accessible. Finding your way around the web is not difficult, but it can be frustrating. The reason is that not all websites are easy to understand and use. In other words, they are not user friendly or usable websites. For a website to be effective, it must be easy to find information on it. A website should be designed to be:

- efficient and deliver the content quickly
- enjoyable and provide a satisfying experience for users
- error free with links that work.

1.1 Explore and evaluate web pages and websites
A website can be evaluated on different criteria, including ease of use, layout and readability. We will now look at some of the aspects that make a website effective, attractive and easy to use.

Readability
Readability of web pages refers to the ease, pleasure and interest with which they can be read. For a web page to be readable, it should have short sentences and not be too busy or cluttered. They should not contain flashing advertisements, graphic objects that blink or move around, or pop-up boxes that cover the text. All of these can annoy a user and prevent them from revisiting the website. The size of the font, the colour contrast of the page and line spacing are all-important to the readability of the website.

Website navigation
Website navigation features should be easy to use in order to access information efficiently.
Website navigation refers to the methods used to move around within a website. Navigation is performed via navigation buttons and tabs, or using hyperlinks. The navigation buttons are also called navigation elements. They are usually grouped in a row at the top of the web page, or in a column down the left side. They should always be visible no matter what page of the website is current.

The navigation buttons are used to help users find and get to the content they want. They should be clear and easy to understand. If you hover over a navigation button, a drop-down menu might appear. If the website is complex, with tens of sections and hundreds of pages, the website designer should include a site map. A site map is a graphic representation of the website layout. It could be a flow diagram, a mind map or organisational chart. The site map should be easy to find and access.

**Consistency**
Consistency means that the user interface has the same look and feel for every page you visit on a particular website. There should be consistency in all the design elements of the website. Design elements are the font choices for headings, the colours, button styles, illustration styles and image choices. If the website uses different fonts, colours and button styles for every page, the user might think they have linked to a different website and wonder how they arrived there.

**Layout**
The website should be well organised and have links that work. The way the website is organised is the site layout. Layout is the placement of text and graphics on the web page. Text and graphics should be aligned to make the page attractive. The page elements should be grouped in a logical and visually appealing way. Page elements are the items that make up a web page, such as tables, images, headings and links. The size of graphic images, where they are placed and how many you use on a page are part of layout design. Viewers will leave the website if the layout does not appeal to them.

**Typography**
Typography is the art of printing and refers to the style and appearance of printed matter. Text formatting, how fonts or typefaces and the amount of white space are used, are typographic considerations. Good typography will make the web page pleasing to look at and easy to read. Font size and colour should be clear against the background colour or graphics. The typography of a page will affect the appeal and readability of a website.

### 1.2 Privacy issues and social implications of the WWW
The WWW is such a big part of modern life that it reaches into many homes, schools and businesses. The WWW makes access to information and entertainment quick and easy. However, the WWW has another side to it. As you browse and look for content, information is gathered about your preferences and habits. Names, contact details, shopping habits, ages, sites visited, are all recorded and used to target users with advertising material.

**Role of databases and respect of privacy**
Large gaming websites, the big online stores, financial institutions all have information about you. If the database of any of these organisations is successfully hacked, that information, including usernames and passwords, falls into the wrong hands. Organisations who keep user details on file are under an obligation to secure that information against hackers. More than that, they may not sell or share that information with any other party.
Internet ethics and respect of privacy
The ease of access to information makes it easy for Internet users to find and use the ideas, writings and products of other people. The Internet is, for some people, a source of free stuff. It is easy to download music, movies, TV series or software, but it is not always legal or ethical. Not every site offering free downloads is authorised to do so. Do not make unauthorised copies of music or DVDs – it is unethical and may be illegal. Many sites that offer free items are full of advertisements, and make their money from advertising. These sites do not care about ethics, as long as they are making money. Be aware that the copyright owner of any website content you that you download has the right to demand payment from you.

Adware
Adware is the name used to describe software that has advertisements embedded in the application. Adware is not illegal. It is given to users free and is a form of barter, or exchange. For example, you get a free computer game and the software developer is paid by advertisers to put adverts in the software. The advert displays either as the free software is installed, or display when the software runs. That might be a fair exchange for someone who does not have money to buy software, but sometimes the adware will contain embedded spyware.

Spyware
Spyware is software that gathers information about you and your Internet use habits, without your knowledge, and sends it to a marketer. The marketer sells this information to advertisers and next time you visit your favourite website, they have an advert targeted to attract you. Spyware may also gather information about e-mail addresses, usernames, passwords and account numbers. Apart from being an invasion of your privacy, this sort of advertising is unethical. In addition, spyware steals from you by using your equipment and Internet connection to send your information to a buyer.
Unit 2  The Internet, WWW and communication (Term 3)

1 Types of digital communication
Digital communication is the way computing devices talk to each other and relies on sets of rules called protocols. A protocol will define, among other things, the data format, the address of the data sender and the address of data receiver. Any data that are sent over any network will need protocols to tell the devices how to interact with each other. Internet Protocol (IP) is the primary protocol of the Internet. Another Internet protocol, TCP, is used by most of the Internet’s applications, including the World Wide Web and e-mail.

1.1 Voice over Internet Protocol
Voice over Internet protocol (VoIP) uses software to convert a voice signal into a digital signal and transmit it over an IP network. VoIP is used by many people to speak to friends or family in other towns, cities and countries. The software can be downloaded from the Internet free. VoIP means a long distance phone call does not have to cost money.

The biggest limitation of VoIP is that there is no quality of service guarantee. This means:
- broken calls, or calls that suddenly end
- delays in transmission of the words
- words lost in transmission
- no fixed point of origin for the call, so an emergency reported on a phone using VoIP, has no known address to which to send emergency vehicles.

1.2 File transfer protocol (FTP)
FTP stands for file transfer protocol. FTP is a standard protocol used to transfer files from one host to another over the Internet. FTP is built into most web browsers. A download from the Internet is generally controlled by FTP.

1.3 Video conferencing
A video conference allows people in two or more locations to interact via video and audio transmissions. It is useful when it is not possible to have face-to-face meetings with people and phone calls or e-mail are inadequate.

Video conferencing is essential when visual information is an important part of the conversation.
Hearing impaired and mute people have a particular interest in affordable video conferencing. It allows them to communicate with each other in sign language.

Video conferencing in the office/the possibilities of video conferencing
The disadvantages of video conferencing cover a wide range. They include:
- Complex systems with no hardware standards for connectivity.
- Quality of service is not guaranteed and you may not get a connection that is fast enough for a high-quality video conference.
- Expense – a well-designed system can cost hundreds of thousands of rand for equipment and devices to interconnect the equipment.
- Some people, especially new users and older people, are self-conscious about being on camera.
1.4 Chat rooms
A chat room is a form of conferencing in which people chat to each other in a virtual room. A chat room can be text-based or it can be a multimedia environment with graphics and sound. Some chat rooms allow the use of both text and voice simultaneously. Every chat room has rules that users must obey. Most chat rooms also have a moderator, who has the right to ban you from the chat room for breaking the rules.

1.5 RSS aggregator
An RSS aggregator is a software application that keeps track of changes made to websites by checking RSS feeds. An RSS feed is a service designed to deliver regularly updated web content to subscribers. To use it, you must subscribe to the service and have the RSS aggregator software. The software is built in to some web browsers or is available for download from the Internet. RSS is useful for people who want content updates, but do not want to use the web each time. Examples of RSS feeds include news, new film or music releases and blogs. Advantages of RSS aggregators include:
- staying informed without having to browse for content
- saving time by not needing to visit each site individually
- ensuring privacy, because there is no need to subscribe to e-mail newsletters.

2 Overview of online services
Online services range from simple services, such as providing data for researchers, to complex services, such as an application for financial aid. Other online services include banking, shopping, bookings and reservations.

2.1 Online stores
Just about anything can be bought online, from books and groceries to motor cars and holidays. Payment methods will depend on what the seller will accept. The most common form of payment for online purchases is using a credit card. However, the lack of a credit card should not prevent you from shopping online, because other payment options are available. These include:
- having the amount charged to your telephone account
- electronic fund transfer
- using a service, such as PayPal, or South Africa’s PayFast or MyGate.

2.2 Online banking or e-banking
All the major banks offer online banking. Registration is quick and may be possible online, depending on the bank. In a mobile and connected world, it makes sense to have access to your bank account wherever you are. It allows you to do your bank transactions whenever you want to, because you can do it on weekends or at night.

2.3 Bookings and reservations
Reservations and bookings for hotel rooms, car hire, theatre tickets, movie and airline tickets, can all be done online. As with other online shopping, payment options vary. However, the options are limited to what the ticket seller or service provider will accept.

2.4 E-commerce or online transactions
Online shopping is also called e-commerce and online banking is called e-banking. The e stands for electronic. With any online payment, there is a risk that other people might get access to your banking details. To prevent this, there are websites and e-payments are usually
done through a secure site. At the beginning of every website address you will find the characters http://. If a website is secure, the first characters will be https:// to indicate that it is a secure site. Secure websites encrypt any information that is exchanged.

3 Social websites
A social website is a website that allows users to establish social relations with people who share interests and activities. The social website will host a profile of each user and maintain their links to friends and family. This activity is generally called social networking. They have become a forum for sharing memories, photos, ideas, activities and events between users.

Advantages and disadvantages social websites
The advantages of social networking sites have grown beyond making contact with old friends, or staying in touch with family. Social websites have also become a platform for exchanging ideas and promoting and launching new consumer products. They have become a business and marketing tool, as well as a social tool. The two big disadvantages are:

- scams and harassment, such as online stalking
- the amount of time spent online reading all the posts and news.

Both could have an effect on productivity at work, and at home or school.

Good practices for social networking
Not everything is what it appears to be on social networking sites. Some people pretend to be someone else, real or imagined. Photos may not be of the real person, details given could be made up. It is good practice to be careful about what personal information you give to people you meet online.

Examples of social networking sites that are used worldwide are Facebook, LinkedIn, Mxit, Google+ and Twitter. Other social websites, such as Badoo and Skyrock, are popular and widely used in Europe and parts of Asia.

4 Overview of mobile Internet access
Mobile Internet access is already in great demand and the demand is growing. This demand has seen new ICT standards being set and new hardware and software being released. At the same time, faster speeds and more stable wireless connectivity are becoming available.

4.1 Portable and mobile – 3G
3G refers to the third generation of mobile phone communication standards. Important services standardised in 3G include:

- telephones with wide-area wireless mobile capability
- mobile Internet access
- mobile video calls
- mobile television.

4.2 Wi-Fi hotspots, WiMAX, Bluetooth
Wi-Fi, WiMAX and Bluetooth are all wireless communication standards. All of them are proprietary, meaning that they are privately owned trademarks. A wireless access point is called a hotspot. A Wi-Fi hotspot has an operative range of about 20 metres indoors, but a greater range outdoors. Hotspots may be found in coffee shops and other public areas, such as airports and some hotels.
WiMAX is the first of the 4G wireless technologies. WiMAX is based on microwave access. 4G is the fourth generation of standards for wireless connections. 4G is faster than 3G, has a greater operating distance and guarantees your connection once it is made. As such, it has the potential to replace Wi-Fi as the preferred choice for high-speed wireless Internet access.

### Advantages and disadvantages of WiMAX

<table>
<thead>
<tr>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed is 10 times faster than Wi-Fi</td>
<td>Expensive to install and operate</td>
</tr>
<tr>
<td>Range is between 10 and 100 times further than Wi-Fi</td>
<td>WiMAX is competing against an established technology</td>
</tr>
</tbody>
</table>

Table 3.1 Advantages and disadvantages of WiMAX

Bluetooth is commonly used for exchanging data over short distances using short wavelength radio transmissions. Bluetooth works from both fixed and mobile devices and can create a personal area network (PAN) with high levels of security. When two Bluetooth enabled devices connect to each other, it is called pairing.

#### 4.3 Limitations of fixed Internet access

The main limitation of fixed Internet access is that it is not mobile. Although this does not suit people who want Internet access on the move, fixed Internet access offers better connectivity and greater speed. Speeds for fixed Internet access are 10 times faster than speeds for mobile Internet access. See Table 3.2 for a comparison of the speed and range of the three wireless access methods and cabled access.

### Table Head Wireless and cable connections compared

<table>
<thead>
<tr>
<th>Connection</th>
<th>Speed</th>
<th>Range</th>
<th>Comments and uses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bluetooth</td>
<td>1 Mbps</td>
<td>10 metres</td>
<td>Up to 100 metres for industrial use</td>
</tr>
<tr>
<td>Wi-Fi – 3G</td>
<td>10 Mbps</td>
<td>20 metres indoors</td>
<td>3G commonly used in mobile devices</td>
</tr>
<tr>
<td>WiMAX – 4G</td>
<td>100 Mbps</td>
<td>6 km to 12 km</td>
<td>1 Gbps for walking or stationary users</td>
</tr>
<tr>
<td>Cable</td>
<td>10 Gbps</td>
<td>As far as the cable runs, including undersea cables</td>
<td>In late 2011, two 100 Gbps fibre optic networks were launched in the USA</td>
</tr>
</tbody>
</table>

Table 3.2 Wireless and cable connections compared

#### 4.4 Cellular data service

A cellular data service is the ability to send and receive data over a cellular telephone network. This is an important part of filling the demand for mobile Internet access.

**Cell phone as a modem**

Mobile phones can be used as modems to provide a wireless connection to a network. The mobile phone provides a link between the cellular service provider’s data network and the computer. Most current mobile phones support the standard commands used for controlling modems. This allows them to be used as a wireless modem to connect a computer.
Browser and e-mail software
A mobile browser is a web browser designed for use on a mobile device, such as a cell phone. Mobile browsers are designed to display Web content on the small screens of portable devices. Modern cell phones and smart phones usually come with web browser and e-mail software as part of the operating system. To satisfy the demand for mobile Internet access a number of browser or e-mail software applications are also available for download.

Website accessibility
Websites designed for access by web browsers are referred to as the mobile web. However, many websites are not accessible to mobile browsers. The reasons for this include:
- images are too big to display on a portable device screen
- wireless connections are too slow to effectively download images
- programs that display some content are not available for mobile devices.
Unit 3  Managing e-mail (Term 4)

1 E-mail management techniques
Once you start using e-mail you will find that your Inbox quickly fills up with messages received. You should delete messages that you no longer need to reduce the number of messages in your Inbox. Despite doing this, your Inbox could soon be crowded with the messages you want to keep. To prevent this happening, you need to organise your mailbox. This will help you to retrieve quickly information when you need it.

E-mails with files attached do not need to be kept if you save the attachment. To save an attachment, first open the message that contains the attachment. In the Message window, double-click on the name of the attachment to open the Opening Mail Attachment dialogue box. Click Open to open the file and then save it with an appropriate name. For example, you may want to save all curricula vitae received in one folder. To do this, create a folder called CV in the My Documents folder. All curricula vitae received can be saved in that folder under the name of the person, such as ArendzA_CV.

1.1 Using e-mail folders
E-mail folders are useful to organise the e-mails you receive. The e-mail application allows you to create, delete, sort, copy and move folders. Most e-mail applications have folders, such as Inbox, Outbox and Sent items. In addition, folders for Deleted items and Junk mail are usually provided. The Deleted Items folder stores any items that you delete, the Junk mail folder is used for spam or other unsolicited e-mail.

Every e-mail application will also allow you to create personalised folders to store mail that is received. This enables you to group e-mails according to the person from whom you received them, or group e-mails by subject. You can also add folders that contain other folders. For example, you can add a content folder called My folders in which you have sub-folders for different subjects. The system administrator may restrict the amount of space available for your e-mail, so do not allow messages to pile up.

1.2 Distribution lists and message rules
Your e-mail application allows you to manage the contact information of people you communicate with. If you regularly communicate with someone, it is a good idea to add their e-mail address to your contact list. Along with the e-mail address, you should store their name, and perhaps a phone number. By having this information on file, you do not have to type it in each time you want to send an e-mail to them. To store the contact details for someone, select File, New, Contact. This will open the Contact Form. See Figure 27 for an illustration of the menus and Figure 28 for the Contact Form. As you can see, there is space for much more than a name, e-mail address and a phone number on the contact Form.

It sometimes happens that you want to send the same message to many people. Instead of sending the message to each person, you can create a Distribution List. The procedure for creating a Distribution List is similar to the procedure for creating a new Contact. Select File, New, Distribution List and the Distribution List dialogue box will appear. Give your Distribution List a suitable name, such as Social Club, by typing it in the Name bar as shown in Figure 29. Next, select the members of the Social club from your Address Book Contacts. You can add a new member by selecting the Add New option and typing in their details. To save your distribution list in your Address Books: Contacts, click Save & Close.
**Message rules**

Message rules are used to filter e-mail messages as they are received. This is useful, because it allows you to sort selected e-mails before they go to your Inbox. The e-mail Message rules can be set to examine a number of different aspects of the e-mail. These include the e-mail subject line, the sender address and the cc field. You can also specify that the rule searches for specific words or phrases in the text of the e-mail. Messages can be flagged for action, deleted or moved to another folder by the Message rules.

**1.3 Sort, flag and prioritise mail**

Microsoft Outlook allows you to flag a message with a flag icon. This means that the message needs to be followed-up. The application will also allow you to set priorities for e-mail to be followed-up. To flag a message, right-click on the message, select Follow Up, then select the desired follow up option to add a flag. Alternatively, select the message and click on the flag icon on the Standard toolbar.

Once you have flagged a message, it will appear in the Inbox with the selected follow up flag next to it. It will also appear on the To-Do bar. You can customise your flagging options by selecting Add Reminder. This will remind you about the follow up on the Reminder date that you set. See Figure 30 for an example of Reminder settings. In the example shown in, the reminder is set for 10 December 2011 at 4:00 PM.

To remove the flag, right-click the message, select Follow Up and click the Mark Complete menu option (See Figure 31). Alternatively, click the Clear Flag button in the Follow Up message dialogue box.

**2 Register a web-based e-mail address**

If you do not want to pay an Internet service provider for an e-mail address, you can register a web-based e-mail address. Some of the more popular web-based e-mail services are Google Gmail, Yahoo! Mail, MSN Hotmail, Lycos FreeEmail and Mail.com. These organisations offer free personal e-mail accounts. The organisation receives money from companies that advertise on their websites and that pays the costs of offering a „free“ e-mail service to you.

Make sure you read and understand the terms of service and privacy agreements before you sign up for any service. To access your e-mail, log on to the website of the e-mail service provider. From here you are able to receive and send e-mail messages. The disadvantage of web-based e-mail is that there is no option to work offline. You have to stay connected to the Internet, and logged on to the service provider’s website, for as long as it takes to download and reply to your e-mails.
Chapter 4  Word processing

Overview

This word processing chapter will revise file management, printing options, using data from different file formats, document layout and editing text. The use of customised bullets and numbering, online templates and electronic forms will also be revised. The quick style gallery is reinforced and the style set feature together with the options to change, create or edit a style are summarised. The mail merge feature focuses on merging documents, envelopes and labels. This chapter also deals with the integration of the word processing application with other applications, such as spreadsheets and databases. References are used to create a bibliography as well as listing a list of sources or table of contents.
Unit 1  Formatting and customising documents (Term 1)

1 File management
- Windows Explorer is a file manager that helps to keep work organised when working with electronic documents. A file manager allows you create, copy, move, rename and delete files and folders.
- When working with a file manager, remember:
  - File and folder names should be meaningful and should describe the contents.
  - File names must be short.
  - File extensions are used to determine which application can open a particular file.

1.1 Printing and print options
It is good practice to make changes to the printer settings and controls before printing. Open the Print dialogue box (Ctrl+P) to select your own printing preferences, for example:
- choose All to print all the pages in a document
- select Current page to print only the page that the cursor is currently on
- select Pages - to print specific pages of a document
- select Number of copies - to select the number of copies to print.

1.2 Sending a copy of the document
Some word processors allow users to send documents from the word processor to another application, such as e-mail. At the Send option, Office Button, you can:
- e-mail the document as an attachment
- e-mail the document as a PDF attachment
- e-mail the document as an XPS attachment
- send the document to an Internet Fax.

1.3 Convert a document
- Some word processing applications will inform you they are in compatibility mode.
- Files that are compatible with other applications are capable of being processed on another computer without any changes.
- Convert the document to the relevant file format at the Office button, Convert, OK.

2 Input data from different file formats
- A file format determines the way in which data is stored in a file.
- The file extension is used by the computer to determine which program is used to open a particular file. For example:
  - TXT file – contains text without any formatting.
  - RTF- may contain formatted text and graphics.
  - CSV (comma separated values or comma delimited file) - is a plain text file where each field in the file is separated from the next field by a comma.
- Tables – data can be transferred from a spreadsheet by copying the data and pasting it into a word processing document as a table.
- To convert files to and from MS Word, right-click on the file and select Open with. From the list of options, select the program you want to open the file.
3 Editing
Editing involves changing text in a document to correct errors and to add/delete text.

3.1 Paste Special
To paste an item using a specific format, for example, data from a spreadsheet into a word processing document as a spreadsheet, a table, a picture or as text, you use the Paste Special button. Select the data that you want to copy. Use Paste Special:
- To insert the contents of the Clipboard as text without any formatting:
  - Click the down-pointing arrow under Paste on the Home tab.
  - At the Paste Special dialogue box click the Paste radio button.
  - Select Unformatted text in the As: list box, then click OK.
- To export spreadsheet data as an object in a word document:
  - Click the down-pointing arrow under Paste on the Home tab.
  - At the Paste Special dialogue box click the Paste radio button.
  - Select Microsoft Excel Worksheet Object in the As: list box, then click OK.

3.2 Find and Replace
The Find and Replace function in the Editing group of the Home tab, searches for every occurrence of a word or phrase.
- At the Find tab of the Find and Replace dialogue box:
  - Find - will search for each instance of the text.
  - Reading Highlight - highlights all the occurrences of the text that you search for.
  - Find in - searches in a specific area of the document, such as Footnotes.
- At the Replace tab of the Find and Replace dialogue box:
  - Replace with - replaces the text that you searched for.
  - Replace All - replaces all the occurrences of the text that you search for.
- The More button gives you check boxes to refine your search:
  - Match case - will limit the search to uppercase or lowercase characters
  - Use Wildcards (*) - will substitute an indefinite number of characters for the (*).
  - Format - will allow you to search for and change font colour, style or size of text.
- The Special button will find and replace special characters, such as paragraph marks.

3.3 Reviewing tools
- Use the buttons on the Review tab to add comments to, and protect, a document.
- Use the AutoCorrect Options button to select or deselect checkboxes to enable or disable various AutoCorrect options that helps to improve the style and appearance of a document.
- Use comments to:
  - add notes and reminders to a draft document
  - share ideas and opinions with others.
- At the Protect group, Review tab, you can specify document protection settings to:
  - prevent other users from making changes to a document
  - set a password for accessing a document.

3.4 Proofing functions
- Use the buttons on the Review tab for proofing functions, such as running a spell check and counting the number of words as you type.
• At the spelling and grammar dialogue box (F7) you can instruct the spellchecker to:
  • use one of the suggested alternatives to replace the word
  • ignore the word or all instances of the word
  • automatically replace the word with the selected alternative as you type.
• Right-clicking a word gives you an option to choose a word with a similar meaning to replace the word.
• To indicate possible spelling and grammar errors while you are working in a document you can click Options in the Spelling and Grammar dialogue box, and Check spelling as you type.
• To find the number of words, characters, paragraphs and lines in a document, find the word count in the Status Bar at the bottom of the window.

4 Page layout
Use the Themes group, Page Layout tab, to replace style formatting, such as colours, fonts and effects that has been used in a document. At the Themes group, you can:
• Choose from a list of Built-In themes to apply a document theme to the whole document.
• Customise a document theme by selecting the Colours, Fonts and Effects options.

5 Document layout
Document layout refers to the design of the document. It involves tasks, such as changing the paper size, margins and page orientation of a document. You use the Page Setup group, Page Layout tab, to insert page breaks, sections and section breaks, headers and footers, page numbers and cover pages in your document.

5.1 Section breaks and sections
• Page breaks mark the point at which one page ends and the next begins.
• Section breaks are nonprinting dividing lines between sections of a document. You use Section breaks to:
  • change the layout or formatting in a portion of the document
  • start a new section on the next page, on the same page, on an even-numbered page or on an odd-numbered page.
• To insert a section break:
  • Click in the document where you want the section break to be.
  • Click the Breaks button on the Page Layout tab, Page Setup group.
  • Click the type of section break that you want to use, for example, Next Page, Even Page or Odd Page.

5.2 Headers and Footers
• Double-click in the header or footer of a document to activate the Header & Footer Tools ribbon.
• Use the Design tab of this ribbon to insert text into, or change the design of, headers and footers. In the header or footer of the document you can:
  • Insert the current date by selecting the Date & Time button.
  • Insert the path and file name by selecting the Quick Parts option and then click Field to open the Field dialogue box.
5.3 **Page numbers**
- Use the Page Number button in the Header & Footer group, Insert tab, to add, format or remove page numbers.
- In a document with sections, use the Design tab of the Header & Footer Tools ribbon to specify different page numbering options for each section.

**Different first page**
- Specifying a different first page can be done from either:
  - the Header & Footer Tools in the Options group
  - the Layout tab of the Page Setup dialogue box.
- In both cases, click the Different First Page check box, then click OK.

**Different odd and even pages**
- You can specify that odd-numbered pages have a different header and footer from even-numbered pages.
- To do this, select the Options group, Design tab, Header & Footer Tools, click the Different Odd & Even Pages check box.

**Start numbering from a specific number**
If you want page numbering to start on page 3, and to begin with page 1:
- Double-click in the header or footer of the document.
- On the Design tab, Header & Footer group, click: Page Number, Format Page Numbers, enter the page number in the Start at box.

5.4 **Add a cover page**
A cover page is the first page of a formal document and this is what is seen first and it should contain the document’s title and the author’s name. To add a cover page, click the down-pointing arrow of the Cover Page button, Pages group, Insert tab. Edit the different sections of the cover page by selecting each table.

6 **Paragraph formatting**
Make formatting changes to paragraphs by customising them (changes according to personal preferences). Lists in documents are usually in the form of a bulleted or numbered list. The items in lists are separate paragraphs that can be formatted.

6.1 **Customise bullets and numbering**
To customise bullets and numbering:
- Click the Home tab, Paragraph group.
- Click the arrow next to the Bullets button to open the bullet library.
- Select a bullet style from the options in the bullet library.
- Follow the same steps to change the numbering style in a numbered list.
Steps to define a new list or change an existing list

<table>
<thead>
<tr>
<th>Define a new bullet format</th>
<th>Change a bullet list level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Define New Bullet on the Bullet library, to open the Define New Bullet dialogue box</td>
<td>On the Home tab, Paragraph group, click the arrow next to the Bullets button</td>
</tr>
<tr>
<td>Click either the Symbol or Picture button to open their dialogue boxes</td>
<td>Select Change List Level</td>
</tr>
<tr>
<td>Enter your settings for the new bullet</td>
<td>Select the level you want to use</td>
</tr>
<tr>
<td>Follow the same procedures to define a new number format</td>
<td>Follow the same procedures to change a number list level</td>
</tr>
</tbody>
</table>

6.2 Outline numbering and multilevel lists

In a multilevel list, the list items of the document are arranged in a ranked order. You can:

- create your own multilevel list style
- choose a multilevel list style from the gallery of built-in styles
- change the numbering level of an item in a multilevel list.

Instructions to use or create a multilevel list

<table>
<thead>
<tr>
<th>To use an existing multilevel list</th>
<th>To create a new multilevel list style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Home tab from the Paragraph group</td>
<td>Click Define new Multilevel list to open the Define new Multilevel list dialogue box</td>
</tr>
<tr>
<td>Click the down-pointing arrow next to the Multilevel List button</td>
<td>Enter the number format, the font, style and position that you want for level 1</td>
</tr>
<tr>
<td>Choose a multilevel list style from the library</td>
<td>Do this for each level of your multilevel list, then click OK</td>
</tr>
</tbody>
</table>

6.3 Customise spacing

- Paragraph spacing refers to the amount of space before or after a paragraph. To change the spacing between paragraphs, select the paragraphs:
  - At the Paragraph group, Page Layout tab, click the Before or After arrows under Spacing.
  - Enter the amount of space that you want. This can also be done under Spacing in the Paragraph dialogue box.
- Line spacing is the space between the lines of text in a paragraph. To adjust the line spacing:
  - Click the down-pointing arrow of the Line spacing button on the Paragraph group of the Home tab.
  - For precise line spacing, click Line Spacing Options to open the Paragraph dialogue box.
    - At least – will set the minimum line spacing needed to fit the text height.
    - Exactly – will set fixed line spacing that will not adjust to fit text height.
    - Multiple – specify your own line spacing value here, for example, 4.
7 Templates: agenda, memo, résumé/CV
- A template is a file with a page layout, font, margins and styles that are suitable for a specific type of content.
- You use the content controls of the template to insert your own content.
- The file type of a template is dotx.
- When you open a template, it creates a copy of itself.
- Templates can be downloaded from the Internet or you can use the templates provided by the word processor.
- To create a template, select New from the Office button menu and click the Installed Templates option.

8 Electronic forms
- An electronic form is a structured document created with blank fields that users can fill in with data. The electronic document can then be protected to restrict users from changing the formatting. The completed data that you collect can be used for reference purposes only or for analysis purposes.
- Two advantages of using electronic forms:
  - Data can be transferred for analysis in a spreadsheet or database.
  - Data validation is possible, because the form can be locked.

8.1 Design a form
- The buttons that are used to create a form are in the Controls group of the Developer tab. To show the Developer tab in the ribbon:
  - Click the Office button and then click Word Options. Click the Popular option.
  - Select the Show Developer tab in the Ribbon check box and then click OK.
- Before you create a form, you should plan it using the following guidelines:
  - Group similar information together, such as name, address and postcode.
  - Use headings to indicate new sections of the form.

8.2 Content controls
- Each content control has properties that you can set or change. The Content Control Properties dialogue box appears when you select the Properties button in the Controls group of the Developer tab.
- Use the buttons of the Control group to do the following:
  - Click the Rich Text content control if you need to include a short paragraph.
  - Click the Plain text content control for simple text fields, such as names or addresses.
  - Click the Picture content control to display an image in the document.
  - Click the Combo Box content control to provide a list of items that users can edit.
  - Click the Drop-Down List content control to provide a list of items that cannot be edited by the user.
  - Click the Check Box content control to insert check boxes that list choices, such as Yes or No.

8.3 Create a form
Step 1: Open a template or a document on which to base the form.
Step 2: On the Developer tab, in the Controls group, click Design Mode.
Step 3: Click where you want to insert a content control. Right click on the content control to
Step 4: Add instructional text to the content controls of the form to help the user fill in the form.

8.4 Protect and unprotected a form
- You can protect a form to allow users to enter information in the form fields without making changes to the form. You can also use a password to protect a form.
- To protect a document:
  - Click the down arrow of the Protect Document button on the Protect group of the Developer tab.
  - Select the Restrict Formatting and Editing option to open the Restrict Formatting and Editing task pane.
  - Select the Allow only this type of editing in the document check box.
  - Under Start enforcement, click Yes, Start Enforcing Protection.
  - At this stage, you can type a password in the Enter new password field.
  - Retype the password in the Re-enter password to confirm field. Then click OK.
- To remove protection settings:
  - Click the Protect Document button in the Protect group of the Developer tab.
  - Click the Stop Protection button in the Restrict Formatting and Editing task pane.
  - If you used a password, enter the password to remove the protection settings.

8.5 Data manipulation
You do not have to retype the data that you gathered electronically in Word. You can import this data into other applications, such as spreadsheets or a database.

9 Import and export data
To import data is to transfer data from one application into another application. To export data is to transfer data out of one application for use in another application.

9.1 Import external data
Use the two commonly used text file formats to help you import data into a spreadsheet:
- Click in the spreadsheet and select the From Text button on the Get External Data group of the Data tab.
- At the Import Text File dialogue box that appears, select a text file (.txt) or a comma separated values text file (.csv).
- In the Import Data dialogue box, you indicate the desired worksheet destination.

9.2 Paste special
Object Linking and Embedding (OLE) allows information to be shared by different applications. To link or embed an object, use the Paste Special command from the Clipboard group on the Home tab.

9.3 Linked objects
For example, you can link a graph from a spreadsheet to a word processing document. To link the graph, select Paste Special to open the Paste Special dialogue box and click the Paste Link button. Select Microsoft Office Excel Chart Object in the As list box and click OK. To update
the graph in the word processing document right-click the chart and select Update Link from the context menu.

9.4 Embedded objects
To embed the data, follow the same procedures for linking an object, but select the Paste button in the Paste Special dialogue box. When you click on an embedded object, the current application will open the tabs and buttons from the source application and allow you to change the data. For example:
- Double-click on the embedded data in the word processing document.
- Use the spreadsheet commands to work with the embedded data.

10 Online and offline help
Help
- Use the Help feature (F7 shortcut key) of the word processor when you are not sure what to do in a word processing application.
- Type a topic in the search box of the Help window and click Search.

Troubleshooting
- Troubleshooting is the processing of analysing the cause of a computer problem.
- A good tip is to start with the most obvious possible cause of the problem and to narrow it down to something specific by a process of elimination.
Question 1

Open the file Valentine. If necessary, use the table on page 2 of the document to key in your answers.

1  Use the editing feature of the word processor to replace the word „Saint” with the abbreviation „St.” and indicate how many replacements were made.  (2)
2  What kind of spacing has been applied to the text of the first two paragraphs?  (4)
3  What option could you choose to replace the music note bullet ♫ with the heart-shaped bullet ♥?  (2)
4  What content control was used for the text field at „Name” in the order form?  (2)
5  List the options that appear in the drop-down list of the order form.  (4)
6  What formatting feature of the word processor was used for the layout of the sample poem (written by Candice)?  (2)
7  Why does the page number (1) not appear on page 1 of this document?  (2)

TOTAL MARKS [18]

<table>
<thead>
<tr>
<th>Answers to Question 1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1  Find and Replace – 6 replacements. ✓ ✓</td>
<td>(2)</td>
</tr>
<tr>
<td>2  Paragraph spacing Before is 6 pt. ✓ Paragraph spacing After is 3 pt. ✓ Line spacing is Exactly ✓ at 12 pt. ✓</td>
<td>(4)</td>
</tr>
<tr>
<td>3  At the Bullets button (Home tab) ✓ → Define New Bullet ✓</td>
<td>(2)</td>
</tr>
<tr>
<td>4  Plain text content control ✓ ✓</td>
<td>(2)</td>
</tr>
<tr>
<td>5  Properties drop-down ✓ Poem, ✓ Teddy bear, ✓ Heart chocolate ✓</td>
<td>(4)</td>
</tr>
<tr>
<td>6  Page Layout → Section Breaks ✓ → Continuous ✓</td>
<td>(2)</td>
</tr>
<tr>
<td>7  Different First Page option ✓ selected at Header &amp; Footer Tools ✓</td>
<td>(2)</td>
</tr>
<tr>
<td>✔ TOTAL [18]</td>
<td></td>
</tr>
</tbody>
</table>
Unit 2  Applying styles (Term 2)

1 Styles
Quick Styles are a set of formats, such as font, size and alignment that you can apply to a paragraph all at once. To show the Styles task pane, click on the dialogue box launcher found on the right-hand side of the Styles group.

1.1 Quick Style gallery
To see the Quick Style gallery, select the Styles group on the Home tab and click the More button. To apply a style:
- Click the Apply Styles option at the end of the gallery list to open the Apply Styles window.
- Select the text in your document to which you want to apply the style.
- At the down arrow of the Apply Styles window, click the style that you want to use, for example, Title.
- As you work in a document, the name of the style that is currently used will appear in the Style Name window.

1.2 Style set
Click on the Style Set button at the Change Styles command to choose a style such as Elegant, for headings and text.

1.3 Change or edit a style
To change or edit an existing style open the Styles task pane and then:
- Click the down-pointing arrow of the style that you want to edit, or right-click on the style.
- From the list of options that appear, click Modify to open the Modify Style dialogue box.
- Click Select All Instances to apply automatically a style to all text that has similar formatting.
- The Clear Formatting option will clear the formatting of all instances of that style.

1.4 Create a new style
- Open the Styles task pane and click on the New Style button at the bottom left of the window.
- This opens the Create New Style from Formatting dialogue box.
- Under Properties, type a name for your style in the Name box.
- Choose a Style Type from the drop-down list.
Unit 3  Mail merge and references (Term 3)

1 Mail merge

1.1 Step-by-Step Mail Merge Wizard
Select the Mailings tab from the Start Mail Merge group and click the arrow next to the Start Mail Merge button. Select the Step-by-Step Mail Merge Wizard option.

Step 1: Select document type
Choose the type of mail merge document that you want to create, such as Letter.

Step 2: Select starting document
Choose the document for your main mail merge document. For example, use the current document to add the recipient information.

Step 3: Select recipients
- Use an existing list. Click on Browse to open the Select Data Source window.
  - Choosing a spreadsheet file, you can select data from any worksheet or range.
  - Choosing a database file, you can select any table or query.
- Select Type a new list to create a database with a table for each recipient’s details.
- Edit the recipient list:
  - Refine the list using the Edit recipient list option.
  - Sort, filter and find duplicates.
  - Select/deselect the check box next to each record to include or exclude recipients.
  - Edit the recipient list using the arrows next to each column heading.

Step 4: Write your letter
- Click in the place where you want to add a field name tag. These tags are recognised by the brackets << >> that mark the place for the information.
- To add data to your document, choose from the list of options, such as More items.
  - Double-click on an item in the More items list to add it to the document.
- Repeat this process for each field you want to insert.

Step 5: Preview your letters
- The preview allows you to view the appearance of the final document.
- Click on the double arrows to preview each record.
- Use the Edit recipient list to make further changes to the list of recipients.

Step 6: Complete the merge
- The merged document is the final document.
- You can Print the document or Edit individual letters.
2 References

2.1 Citations and bibliography
- Choose a reference style, such as APA, to create a reference list.
- Select the References tab, Citations & Bibliography group and click the arrow next to the Style button.
- Choose a style, such as APA, and use it consistently throughout the document.

Citations
- To insert a citation, click the arrow at Insert Citation button, Citations & Bibliography group.
- If this is a new source, click Add New Source then select the Type of Source. Complete the Create Source Form, OK.

Bibliography
- Click in the document where you want the bibliography to appear.
- On the Citations & Bibliography group, click the Bibliography button.
- Use the options listed to generate an automatic bibliography of works cited, or you can insert your own bibliography.

2.2 Footnotes and endnotes
- To insert a footnote, click in the document where you want to insert the footnote.
- At the References tab, Footnotes group, click the Insert Footnote button.
  - The footnote number appears at the end of the page with the insertion point.
  - You can now type the notes to the text.
- To insert an endnote you click the Insert Endnote button. The endnote will appear at the end of the document.

2.3 Captions
- To add a caption to a picture, first click on the picture.
  - Click References tab, Captions group, Insert Caption.
  - Click the Label option if you want to type a new label.

2.4 Table of contents
- The Table of Contents appears at the beginning of a long document.
- In word processing, a Table of Contents entry is marked by selecting the text that is to appear in the Table of Contents:
  - Select the text that you want to include in the Table of Contents.
  - In the Table of Contents group, click Add Text.
  - Select the level at which you want to display the text. For example, Level 3 will display the text as a third level heading.
  - All the text that you add is automatically included in the Table of Contents.

Create a Table of Contents
- Place the cursor where you want to insert the Table of Contents.
• Click References tab, Table of Contents group, Table of Contents button, Insert Table of Contents.
• At the Table of Contents dialogue box click check boxes to:
  • Show page numbers and Right align page numbers using different Tab leader styles
  • Use Formats box to choose a design, such as Fancy
  • Click Options, TOC level to place headings at specific outline levels.

**Update a Table of Contents**

• If you make changes to a document, you can update the Table of Contents.
• At the References tab, Table of Contents group, click the Update Table button.
Question 2

Open the file Poem.

1. Use the APA style and cite the source of the poem at the yellow shaded area. The poem, Be Mine, was written by Candice Jones from Cape Town in 1999, and published in a book of poems by Doubleday publishers. (4)

2. The citation at paragraph 2 on the second page must read Choko not Chen. (2)

3. Add a caption (Figure 4) below the image on the last page in a similar format to the captions on the previous page. (5)

4. Convert the endnote, ♥ A typical promenade, to a footnote. (2)

5. Create a table of contents on page 1 under the heading TABLE OF CONTENTS. Use the format Distinctive and include only the headings of Heading 1 style. (5)

TOTAL MARKS [18]

<table>
<thead>
<tr>
<th>Answers to Question 2</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 APA style ✔ insert citation ✔ Add a new Source ✔ Book ✔ insert text ✔ ✔</td>
<td>(4)</td>
</tr>
<tr>
<td>2 Citation at paragraph 2 (pg 2) edited ✔ to read Choko ✔</td>
<td>(2)</td>
</tr>
<tr>
<td>3 Caption inserted below the image ✔ Figure 4 ✔ centred ✔ , Comic Sans ✔ 16 pt ✔</td>
<td>(5)</td>
</tr>
<tr>
<td>4 Endnote converted to footnote ✔ ✔</td>
<td>(2)</td>
</tr>
<tr>
<td>5 Table of contents inserted ✔ on page 1 ✔ in Distinctive format ✔ only Heading 1 style ✔ ✔</td>
<td>(5)</td>
</tr>
<tr>
<td>TOTAL</td>
<td>[18]</td>
</tr>
</tbody>
</table>
Unit 4  Mail merge and integration (Term 4)

1 Merge envelopes and labels
The Mail Merge Wizard is used to create a set of personalised letters. To create matching envelopes or address labels, you use a similar process.

1.1 Envelopes
Open a blank word processing document and follow the mail merge wizard.
Step 1: Select document type, click Envelopes.
Step 2: Select starting document, Envelope options, envelope size DL, OK.
Step 3: Select recipients, use the Browse option to browse for the data source.
Step 4: Arrange your envelope, and follow the same process as for a form letter.
Step 5: Preview your envelopes, to view how the address appears in the document.
Step 6: Complete the merge.

1.2 Labels
Printing labels is similar to the process used to create personalised envelopes. Open a blank word processing document and follow the mail merge wizard.
Step 1: On the Mail Merge task pane, select Labels.
Step 2: Click Label options.
Step 3: Select the address list and edit it, if necessary.
Step 4: Arrange your labels.
  - Click on the first label and select the items from the More items list.
  - Click the Update all labels options to copy the layout of the first label to the other labels.
Step 5: Preview the label print.
Step 6: Complete the merge.

2 Integration with other packages
- In Unit 1 you used the Paste Special button to link objects to different applications.
- You also used the import and export features to transfer data.

Hyperlinks
- Hyperlinks are another way to share and exchange information between applications.
- A hyperlink is an object that you click to take you to another place in the same document or to a different document.
  - Hover the mouse over a hyperlink to view the file path information.
  - To follow the link, press Ctrl and click the mouse button.
  - To set up a hyperlink, click Insert, Links, Hyperlink to open the dialogue box.
  - At this dialogue box, you have options to link to an existing file or web page.
  - You can select a specific object to link to in the document, such as a bookmark or a file.
Question 3

1 Personalised envelopes need to be sent to many different recipients in Grade 11.
   - Use the DL size envelope and the SG3 database to prepare for a mail merge.
   - The Orders database contains the data source for the envelopes.
   - Envelopes are issued to recipients who have a rating of more than five.
   - Sort the recipients in descending order of the Ratings column.
   - Add the merge fields Name and Surname. Leave a space between Name and Surname.
   - Save this document as Merge before completing the merge.
   - Save the results of the merge as MergeComplete. (10)

2 Open the file DJ. If necessary, key in your answers in the table (page 2).
   - Complete the sentence. Figure B has been linked to a ... in the same document with the name ... (2)
   - Name two other objects in this document that have been hyperlinked and, in each instance, give the name of the hyperlink. (4)
   - Create a link on the word POEM to the file Link. (4)

TOTAL MARKS: [20]

<table>
<thead>
<tr>
<th>Answers to Question 3</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Mail merge DL envelope. ✓</td>
<td>(1)</td>
</tr>
<tr>
<td>Correct data source Orders is used. ✓</td>
<td>(1)</td>
</tr>
<tr>
<td>Envelopes prepared for recipients with a rating of more than 5 ✓</td>
<td>(1)</td>
</tr>
<tr>
<td>Recipients sorted in descending order of Ratings ✓</td>
<td>(2)</td>
</tr>
<tr>
<td>Merge fields Name ✓ and Surname ✓ with a space between Name and Surname ✓</td>
<td>(3)</td>
</tr>
<tr>
<td>Merge is correctly saved as Merge ✓ and MergeComplete ✓</td>
<td>(2)</td>
</tr>
<tr>
<td>2 Bookmark ✓ → Cell_number. ✓</td>
<td>(2)</td>
</tr>
<tr>
<td>Angie ✓ Photos ✓ Flower image ✓ Flowers ✓</td>
<td>(4)</td>
</tr>
<tr>
<td>Select the text POEM ✓ Insert tab → Links → Hyperlink ✓ Link in: This folder ✓</td>
<td>(4)</td>
</tr>
<tr>
<td>Link to: Link ✓</td>
<td></td>
</tr>
</tbody>
</table>

TOTAL [20]
Chapter 5  Spreadsheets

Overview

In this chapter you will learn about Absolute cell referencing and Auto Fill options; Rounding options; SMALL, LARGE, COUNTIF, COUNTA, COUNTBLANK, SUMIF, POWER and RAND functions; conditional formatting; interpreting error indicators; circular references and #NULL!; IF functions and the use of relational operators (>, =, <, <=, >=, <>); creating, formatting and editing charts; integration techniques; importing and exporting data; working with Help; working with worksheets; print options and templates; integration techniques within spreadsheets; integration techniques with other applications; planning and designing your own documents; and problem solving and troubleshooting.
Unit 1  Formatting, formulas and functions
(Term 1)

1 Reinforce spreadsheet concepts and skills
- Spreadsheets are used for working with figures and charts
- Spreadsheets are made up of columns and rows – each block is a cell
- A cell range is a group of cells next to one another (horizontal or vertical)
- Each sheet in a spreadsheet is also known as a worksheet
- The spreadsheet file is called a workbook
- Calculations are done in a specific order – calculations with in brackets are done first, then division and multiplication then addition and subtraction
- Functions you should know include SUM, MIN, MAX, AVERAGE, COUNT, TODAY, RAND, MODE, MEDIAN
- An error indicator appears when a formula does not work in a worksheet

2 Cell referencing
- A relative cell reference occurs when a cell reference changes every time the formula is copied to another cell.
- An absolute cell reference occurs when a cell reference remains fixed and refers to the same cell, no matter which cell the formula is copied to.
- To keep a cell absolute the formula is $column$row. For example, $D$1.
- The shortcut key to set an absolute cell reference is F4.

3 Auto Fill options
- Auto Fill can be used to copy a list of cells, or
- To fill a series of sequential data, such as Monday, Tuesday, Wednesday ...
- To copy formatting of the original cell
- To copy data without the formatting.

4 Spreadsheet functions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Purpose</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMALL</td>
<td>Finds the smallest specified number, for example, the third smallest number in the cell range A3:A8</td>
<td>=SMALL(A3:A8,3)</td>
</tr>
<tr>
<td>LARGE</td>
<td>Finds the largest specified number, for example, the fourth largest number in the cell range A3:A8</td>
<td>=LARGE(A3:A8,4)</td>
</tr>
<tr>
<td>COUNTIF</td>
<td>Finds how often specific criteria appear in a cell range, for example, how often Gr11 appears in the range A3:A8.</td>
<td>=COUNTIF(A3:A8,&quot;Gr11&quot;)</td>
</tr>
<tr>
<td>COUNTA</td>
<td>Find the number of cells that contain</td>
<td>=COUNTA(A3:A8)</td>
</tr>
</tbody>
</table>
### Examples of spreadsheet functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNTBLANK</td>
<td>Finds the number of blank cells in a range, for example, count the blank cells in the cell range A3:A8.</td>
<td>=COUNTBLANK(A3:A8)</td>
</tr>
<tr>
<td>SUMIF</td>
<td>Adds figures in a range of cells if specific criteria are met, for example, totals the amount raised by Grade 11.</td>
<td>=SUMIF(A1:A6,&quot;Grade11&quot;,B1:B6)</td>
</tr>
<tr>
<td>ROUND</td>
<td>Rounds figures off to a required number of decimal places, for example, round the contents of cell A1 to three decimal places.</td>
<td>=ROUND(A1,3)</td>
</tr>
<tr>
<td>POWER</td>
<td>Finds the result of a number raised to a specified power. The example calculates the value of the figure in A1 to the power of two.</td>
<td>=POWER(A1,2)</td>
</tr>
<tr>
<td>RAND</td>
<td>Randomly selects a number between 0 and 1 every time the spreadsheet is opened.</td>
<td>=RAND()</td>
</tr>
</tbody>
</table>

- Functions can be inserted using the insert function (fx) icon or typed directly into the formula bar.

#### 4.1 SUMIF and COUNTIF functions
- SUMIF is suitable for add the value of a specific criteria.
- COUNTIF counts how often a specific criterion occurs.

#### 5 Rounding options
- The ROUND function will round figures below .5 down and figures .5 and higher will be round up.
- For example, using ROUND will round 11.3 down to 11 and 11.6 up to 12.
- This is mathematically correct and different from increasing or decreasing decimals on the Home Ribbon.

#### 6 Conditional formatting
- Format cells that meet specific conditions.
- Data in cells can be formatted using operators, such as greater than, less than, between and equal to.
- Data can be figures or text.
- Font size, font style, font colour, borders and shading can all be formatted.
- Other formatting options, including working with averages, top or bottom results of a range.
- Conditional formatting can be used to quickly find important information or trends within data.
- Conditional formatting rules can also be edited and deleted according user needs.
7 Interpret error indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Reason</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>#######</td>
<td>Column is not wide enough to display the contents</td>
<td>Make the column wider</td>
</tr>
<tr>
<td>#NAME!</td>
<td>Incorrect function name in formula (typing error or unknown function)</td>
<td>Check spelling of function names in the formula</td>
</tr>
<tr>
<td>#DIV/0!</td>
<td>Formula attempts to divide by 0, which is not possible in mathematics</td>
<td>Find and correct the error in the cell reference or cell contents</td>
</tr>
<tr>
<td>#REF!</td>
<td>The cell reference in the formula is no longer valid (the cell has been deleted)</td>
<td>Change cell reference to refer to the correct cell</td>
</tr>
<tr>
<td>#N/A</td>
<td>Formula refers to a cell that is not available any more</td>
<td>Correct the cell reference</td>
</tr>
<tr>
<td>#VALUE!</td>
<td>Incorrect value used in the cell (e.g. a text value being multiplied)</td>
<td>Correct the cell value or cell reference</td>
</tr>
<tr>
<td>#NUM</td>
<td>Invalid number in a formula (e.g. a negative instead of a positive number)</td>
<td>Correct the value in the relative cell</td>
</tr>
</tbody>
</table>

7.1 Circular reference
- The cell where the function is inserted has been included in the range within the formula.
- A Circular Reference Warning is issued and can be accepted as is or corrected.

7.2 #NULL!
- The cell reference in a function is not correctly separated
- For example, a colon (:) is missing from the cell range
- The Error Checking dialogue box on the Formulas Ribbon can be used to find and correct errors in a function
Unit 2  IF function, charts and integration (Term 2)

1 IF function
- Tests whether a specified criterion has been met.
- Performs one of two actions based on the result:
  - If True, the first action is performed (returns Yes or any other alternative answer).
  - If False, the second action is performed (returns No or any other alternative answer).
- Can be typed in or inserted using the IF function.
- Commas are used to separate the arguments.
- To return a blank answer use “ ”.

2 Relational operators and the IF function
- Relational operators can be used to test conditions in an IF statement.
- These operators include = Equal to, < Less than, > Greater than, >= Greater than or equal to, <= Less than or equal to, <> Not equal to.

3 Working with Charts
- A chart provides graphic representation of data in a worksheet.
- Charts should contain additional information, such as a title, labels and legend.
- There are different charts suitable for different occasions:
  - Pie chart – represents data as percentages/values adding up to 100.
  - Column/Bar chart – used to compare values over a period of time.
  - Line chart – used to identify trends over a longer period of time.
  - Scatter chart – used to show relationships between two different data sets.
  - Area chart – used to show changes in sets of data over a period of time.
- Remember charts should:
  - Be easy to interpret and understand.
  - Be attractive in colour and formatting.
  - Add value to the written data or presentation.
  - Be carefully designed and labelled.

3.1 Chart titles and labels
- Chart titles, axis titles and data labels make charts easier to read and interpret.
- Chart titles should be short and meaningful.
- Axis titles are added for charts that have an x-axis (category axis) and a y-axis (value axis).
- Formatting, position and type of data labels can be adjusted to the requirements of the chart.

3.2 Gridlines
- Horizontal and vertical gridlines can be added to make the chart easier to read.
- Major gridlines are bolder and mark larger increments (100, 200 etc).
- Minor gridlines are lighter and mark smaller increments (1, 2, etc).
3.3 Legends
- A legend is a key used to identify the colours used for each category in a chart.
- The legend can be placed on the top, bottom, left or right of a chart; or it can be hidden.
- The legend should be clear and easy to understand.

3.4 Options appropriate to chart type chosen
- The type of chart used is influenced by what it is meant to represent.
- 3-dimensional (3-D) effects can be added to charts.

4 Integration techniques
- Data can be included from one application into another.
- Sometimes copy and paste is sufficient and appropriate to the integration.
- For example, charts from spreadsheets can be pasted into a word processing document.
- It is possible to integrate data, such as charts, in a way to allow updated spreadsheet data to be updated in the word processing file.
- This requires the chart in the spreadsheet to be linked to the pasted chart in the word processing file.
- This is done by using the Paste Special option and pasting the link as a Microsoft Excel Chart Object.
- It is easy to update any changes by right-clicking on the chart in the word processing file and selecting the Update Link option.
1 Import and export data
- Remember importing data means you bring it into the application from another, whereas exporting means you send it from the application into another.
- Working within an Office Suite makes importing and exporting of data very easy to do.

1.1 Export data from a database to a spreadsheet
- Database objects (tables, queries, forms and reports) can be exported into a spreadsheet.
  - Locate the database object to be exported.
  - Determine the destination where the object is to be exported to.
  - Click on the External Data tab and from the Export menu select Export to Excel Spreadsheet.
  - Alternatively you can right click on the object you and select the Export option.
  - When exporting data, ensure you export data with formatting and layout and choose Open the destination file after the export operation is complete, if you wish to work with the exported data.
  - Click on OK to complete the export process, then click OK.

1.2 Import data from a database into a spreadsheet
- Working in the spreadsheet file.
  - Click on the Data tab, select From Access in the Get External Data group.
  - Locate the database file and then select the object to be imported.
  - In the Import Data tab, either place the data in a New worksheet or in an Existing worksheet.

2 Help files
- The F1 key is the shortcut to using the Help menu.
- Help can be accessed online, but is also available offline.
- Help topics can be found by browsing the Help table of Contents or searching using suitable keywords.
- It is also possible to access tutorials and step-by-step instructions for further assistance.

3 Work with sheets
3.1 Moving and copying worksheets
- Worksheets can be moved within in a workbook by clicking on the tab and dragging the sheet to the desired position.
- Worksheets can be copied within the workbook or to another workbook by right-clicking on the tab.
- The same process is also used to move worksheets to new workbooks.
- Ensure you understand the difference between copying and moving.
3.2 Freeze Panes and Unfreeze Panes
- Use the Freeze Panes option when working with large amounts of data.
  - You can freeze the top row of a worksheet
  - You can freeze the first column of a worksheet
  - You can select a cell and then freeze the row/s above and column/s to the left of the selected cell

3.3 Protect a worksheet or workbook
Data is protected to prevent unauthorised access or to prevent changes being made to it.

Protect a workbook
- The Protect Structure and Windows dialogue box prevents any changes from being made to the workbook.
- The Protect Sheet dialogue box can prevent or allow changes to be made
- Protect a workbook with a password
- This is done through the Tools option within the Save As menu.
- Remember that if a password is lost or forgotten, you will probably lose the data.

3.4 Headers and Footers
- Can be found on the Insert menu
- Allow you to add data that will be useful to the reader, such as:
  - the name or descriptive information about the content
  - the date created, or modified
  - the author’s name and other details.

3.5 Other worksheet options
- Spreadsheets allow you to:
  - insert or delete a worksheet
  - rename a worksheet
  - change the tab colour of a worksheet
  - hide a worksheet from view

4 Print options
4.1 Print areas
- You can choose to:
  - print a portion of a worksheet
  - print the entire worksheet
  - print an entire workbook.

Print Preview option
- This provides you with an idea of what the printed document will look like.
- It is a useful tool for checking for mistakes and typing errors.

Print using the Page Setup dialogue box
- Before printing changes can be made to the document
  - Page orientation – landscape or portrait.
• Scaling – reduce the number of pages the spreadsheet uses, or increase it to make it easier to read the spreadsheet.
• Paper size and Print quality – these can be changed at this point.
• The Sheet tab of the Page Setup dialogue box offers four options:
  – Print area – select the specified area to print.
  – Print titles – select the columns or rows you would like to print as headings.
  – Print – select gridlines, print quality, column letters and row numbers, print comments and print error messages.
  – Page order – select the order in which you would like the pages printed.
• This is done by linking cells within a workbook or between workbooks.

5 Integration within spreadsheets
Formulas and functions can be linked within a workbook.

5.1 Linking cells and formulas between sheets
• Can be done by typing an equal sign in the cell where you would like the data copied/linked (destination cell).
• Click on the cell where the data is originally stored (source cell), and then press Enter.
• Remember changes to the source cell will affect the destination cell.
• Alternatively, you can click on the source cell, followed by the Copy button on the Home row.
• Then select the destination cell and select the Paste Special option and click Paste Link.
• Remember the first method uses relative cell references, whereas the second method uses absolute cell referencing.
Unit 4 Solving problems with spreadsheets
(Term 4)

1 Consolidate content, concepts and skills
- Regular practice is essential in order to be able to master your examinations.

2 Templates
- These are pre-defined settings, such as font, margins, styles and calculations.
- Templates are time-savers and provide assistance in areas where difficulty is experienced.
- The Office Suite offers a large variety of online templates for download.

3 Designing documents for a specific scenario
- Spreadsheets can be used by anybody working with numbers.
- Understand what needs to be accomplished with the spreadsheet.

4 Integration and problem-solving
- In order to import data from a database into a spreadsheet:
  - Select the Get External Data option on the Data tab.
  - Browse for the required file.
  - To place data in separate columns select a delimiter (comma, tab, space, semi-colon).
- Charts can be linked to a word processing file in order to ensure changes made in the spreadsheet update in the word processing file.

5 Troubleshooting
- Most spreadsheet problems are caused by incorrect data capture, incorrect data types or incorrect functions being used.
- Some checks can be done when encountering a problem. These include:
  - Ensure every functions starts with an equals sign.
  - For every bracket opened there must be one to close.
  - Ensure all required arguments have been entered in functions, remember text arguments must be enclosed by inverted commas.
Questions

Study the screenshot below and answer the questions that follow.

![Excel spreadsheet screenshot](image)

4.1 What formatting feature has been used in row 1? (1)

4.2 Identify the function that has been used in the following cells – write out the entire function in full.

   4.2.1 Cell C19 (2)  4.2.3 Cell 21 (2)
   4.2.2 Cell C20 (2)  4.2.4 Cell C22 (4)

4.3.1 What formatting technique would you use in Column C to highlight amounts above R200 000? (1)

4.3.2 Specify which rule you would apply to ensure this occurs. (1)

4.4 Identify a problem with the way in which the data in cell range C4:C15 is formatted. Indicate how you would correct this problem. (2)

4.5 Identify a function that would determine how many consultants started working in 2009. Write this function out in full. (3)

4.6 Name the technique or feature you would use to do the following:

   4.6.1 Print cell range A19:C22 (1)
   4.6.2 In cell B3 place the word started under the word Year, keeping the data in one cell. (1)
   4.6.3 Ensure rows 3–16 are not seen by people viewing the data. (1)

4.7 What type of chart would you suggest be used to illustrate the income raised by the travel consultants? Provide a reason to support your choice. (2)
4.8 The data needs to organised in order by Year Started and then by Consultant name. Specify exactly how you would do this. (2)

**Answers**

4.1 Merge and centre.
4.2.1 =SMALL(C4:C15,3)
4.2.2 =COUNTBLANK(D4:D15)
4.2.3 =COUNTA(A4:A15) or =COUNTA(B4:B15)
4.2.4 =SUMIF(B4:B15,2011,C4:C15)
4.3.1 Conditional formatting
4.3.2 Greater than
4.4 The data is formatted using the Accounting data type. It should be Currency.
4.5 =COUNTIF(B4:B15,2009)
4.6.1 Set the Print Area or highlight the cells and choose print selection from the printing options.
4.6.2 Text wrapping
4.6.3 Hide the rows
4.7 Column or Bar Chart, because the different totals can easily be compared.
4.8 Choose Custom Sort from the Sort option on the Home Ribbon. Add a level for each category to be sorted by.
This chapter comprises of four units covering the basic concepts, knowledge and skills required for databases. This chapter explains basic skills, such as creating and editing tables, queries, forms and reports; assigning data types; data validation; and doing calculations and integration. In this chapter you will learn about tables, records, fields and data types; record manipulation; basic field properties; formatting and editing; forms; basic data validation; basic queries; simple reports; calculations; and integration techniques.
Unit 1  Database concepts and basic skills  
(Term 1)

1 Databases and their uses

- A database is application software that allows you to store and manage a collection of related data.
- Databases are divided into:
  - Tables – where records are saved.
  - Queries – used to extract certain information.
  - Forms – a user-friendly way to input data.
  - Reports – a summary of selected information.
- Databases can be used to:
  - create an address book and extract the information you need
  - create a list of all the songs per artist that you have on your computer
  - find all BMW motor cars
  - print a Report of a specific student’s marks.

2 First looks

- To start the database application, click Start, All Programs, select Microsoft Office and then Microsoft Office Access.
- Three options are available once you have started the program:
  - create a database from existing templates
  - create a database from templates available on line
  - create a blank database.

Database screen
2.1 Objects

Objects are the parts that define the structure of the database, such as the Tables, Queries, Forms and Reports.

<table>
<thead>
<tr>
<th>Object</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>stores the data</td>
</tr>
<tr>
<td>Query</td>
<td>based on criteria you select, Query extracts the data in the table that matches your criteria</td>
</tr>
<tr>
<td>Form</td>
<td>data entry windows make it easy for users to enter data</td>
</tr>
<tr>
<td>Report</td>
<td>organises and/or summarises both the table and the queries</td>
</tr>
<tr>
<td>Macro</td>
<td>A recorded set of keystrokes and commands that are designed to perform particular tasks</td>
</tr>
<tr>
<td>Module</td>
<td>small programs, written in the Visual Basic language, for functions not included in Access</td>
</tr>
</tbody>
</table>

Table 6.1 Objects available in a database

3 Tables, records, fields and field names

- A row is called a record and a column is called a field. A value that is entered in a field forms one part of the record. A value that is entered in a field forms one part of the record.
- In Design View, you can enter the field name and choose the data type from the options given.
- In Datasheet View you can add a new field by entering information, rename the column and choose a data type.

4 Data types

Every field will have its own data type. A data type determines the format of the data that will be entered.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text:</td>
<td>Data that does not need calculations and is not Date/Time</td>
</tr>
<tr>
<td>Memo:</td>
<td>Long alphanumeric text, such as a comment</td>
</tr>
<tr>
<td>Number:</td>
<td>Numbers used for calculations</td>
</tr>
<tr>
<td>Date/Time:</td>
<td>Used for date and time</td>
</tr>
<tr>
<td>Currency:</td>
<td>Money values</td>
</tr>
<tr>
<td>Yes/No:</td>
<td>Used when only one of two values can be selected, such as Yes/No or True/False</td>
</tr>
<tr>
<td>OLE Object:</td>
<td>Used to attach an object, such as a spreadsheet or picture that will automatically</td>
</tr>
</tbody>
</table>
Data types in MS Access 2007

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Object Linking and Embedding)</td>
<td>update in the database when the source data changes</td>
</tr>
<tr>
<td>Hyperlink:</td>
<td>Used to store a link to another file</td>
</tr>
<tr>
<td>Attachment:</td>
<td>Used to attach a file. More than one file can be added</td>
</tr>
<tr>
<td>Lookup Wizard:</td>
<td>Creates a field that allows you to choose a value</td>
</tr>
<tr>
<td>AutoNumber:</td>
<td>Numbers automatically added when a new record is entered</td>
</tr>
</tbody>
</table>

Table 6.2 Data types in MS Access 2007

5 Primary key
- A primary key is a unique identification field that is used to identify records.
- Right-click on the field in Design View and choose primary key to set the primary key.

6 Basic field properties
Field properties control what a data type does and how it appears.

Field properties

<table>
<thead>
<tr>
<th>Field property</th>
<th>What the field property does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field size</td>
<td>An allocated memory space is created once a data type is chosen. Sometimes it is not necessary to use all the space allocated. It is advisable to change the field size so that unnecessary space is not wasted.</td>
</tr>
<tr>
<td>Format</td>
<td>Some data types allow you to select the format. By formatting a field, you change how data displays in a field, or what the field layout will be.</td>
</tr>
<tr>
<td></td>
<td>The Number and Currency data types allow you to choose how numbers are displayed. The options are: General Number, Currency, Euro, Fixed, Standard and Percent.</td>
</tr>
<tr>
<td></td>
<td>The Date/Time data type allows you to specify the layout of the Date and the Time. The available options are General Date (1/01/2010 12:00:00 PM), Long Date</td>
</tr>
<tr>
<td></td>
<td>(Sunday, January 1, 2010), Medium Date (01-Jan–2010), Short Date (1/01/2010), Long Time (12:00:00 PM), Medium Time (12:00 PM) and Short Time (12:00).</td>
</tr>
<tr>
<td></td>
<td>The Yes/No data type allows a specific format. The available options are True/False, Yes/No and On/Off.</td>
</tr>
<tr>
<td>Decimal Places</td>
<td>The Number and Currency data types allow an additional option to set the decimal places.</td>
</tr>
<tr>
<td>Caption</td>
<td>Caption will change the display of the field name in the Datasheet view. It will not change the field name in Design View.</td>
</tr>
<tr>
<td>Default Value</td>
<td>A default value will display automatically in the field in Datasheet view.</td>
</tr>
<tr>
<td>Required</td>
<td>The required property indicates that something must be entered in this field. It cannot remain empty.</td>
</tr>
<tr>
<td>Indexed</td>
<td>An index in a field will make searching and sorting faster.</td>
</tr>
<tr>
<td>Text align</td>
<td>The alignment of text in a field.</td>
</tr>
</tbody>
</table>

Table 6.3: Field properties
7 Changing views

Datasheet view is where the data is displayed, whereas Design is where the fields and data types are viewed. Use the Home tab to switch between views.

8 Working with data

8.1 Creating tables

Data is stored in tables. To create a table, click the Create tab, then select Table.

8.2 Entering data

To add data, type it in, in Datasheet view.

8.3 Add and delete records and fields

- To add a new record, click the New (blank) record icon on the record navigator bar at the bottom of the screen in Datasheet view.
- To delete an existing record in a table, select the entire row and press delete on the keyboard.
- To add a new field to a table in Datasheet view, move to the last column of the table. Enter the information and rename the column to the desired name.
- To delete existing fields in Datasheet view, select the column and press delete on the keyboard. In Design View, select the row and press delete on the keyboard.

8.4 Formatting and editing

Change data in a table, form or query by working directly in Datasheet view.

<table>
<thead>
<tr>
<th>Format</th>
<th>Explanation</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing row height and column width</td>
<td>Right-click the row and select Row Height, or right-click the column and select Column Width. You can also click-and-drag to make the row or column bigger. Click on the column/row border you want to move, hold down the mouse button while moving the mouse.</td>
<td>Changing row height</td>
</tr>
<tr>
<td>Apply bold, italic, underline to text. Changing font, font size, font colour etc. Changing alignment.</td>
<td>Use the Font group on the Home tab to select font, font size, font colour, bold, italic, or alignment. Note: when you change something for a single cell, you change it for all the cells in the datasheet.</td>
<td>Applying text formatting</td>
</tr>
<tr>
<td>Hide/Show columns</td>
<td>To hide columns, select them and right-click. Then select Hide Columns from the menu. To display hidden columns, right-click and select Unhide</td>
<td>Hiding/unhiding columns</td>
</tr>
</tbody>
</table>
8.5 Sorting
- To sort data in a database:
  - select the data to be sorted
  - then select the Ascending or Descending icon in the Sort & Filter group of the Home ribbon.

9 Basic data validation techniques
- Data validation is a way of controlling what users enter. Some basic data validation techniques:
  - that data type controls what users can enter
  - by setting field sizes a user can be prevented from entering large amounts of text into the field
  - table properties also provide a type of validation.

10 Filters
- To locate records without using a query, apply a filter.
- To activate a filter, select the data, right-click it and select the filter from the options in the drop-down menu.
11 Creating Forms

- Forms are created to allow users to enter, edit and delete data easily.
- A form is created by using the Form Wizard. On the Create tab in the Forms group select More Forms and then Form Wizard.
- Select the table and the fields.
- Select the layout and style for the form.
- Give the form a name.
Unit 2  Table design and Queries (Term 2)

1  **Design database Tables**
- Things to consider in the design phase are:
  - the type of data to be entered
  - which field should be the primary key
  - the size of fields and how to ensure that the correct data are entered.

2  **More about data types**
Data types are the essential elements that make up a database table.

2.1  **Hyperlink**
A hyperlink is an electronic shortcut that you click to navigate to somewhere else.

2.2  **Attachment**
An attachment is a file, image, sound or video that can be added to records.

2.3  **OLE object**
An OLE object is an image, document, graph or any other object that is inserted as a data type.

2.4  **Lookup data type**
- To create a Lookup Column:
  - Switch to Datasheet view.
  - Select the Datasheet tab.
  - In the Fields & Columns group, click on the Lookup Column icon. The Lookup Wizard will appear:
    - select whether the values will be typed in or looked up in another table
    - type the values
    - enter the name of the Lookup Column and click on Finish.

3  **Advanced field properties**
Field properties help to define the field and tighten the validation procedures.

3.1  **Input masks**
- Input masks are used to control how data is entered by displaying the style or format the data must have.
- To insert an Input mask:
  - Select Field Properties, Input Mask and [press F1]
  - Select Text Box. Input Mask Property and scroll through the window to find the characters for defining input masks.
**Characters used to define an input mask**

<table>
<thead>
<tr>
<th>Character</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A numeric digit, in the range 0 to 9, is required</td>
</tr>
<tr>
<td>9</td>
<td>Optional digit or space</td>
</tr>
<tr>
<td>#</td>
<td>Not required digit or space, blanks are changed to spaces, plus and minus signs</td>
</tr>
<tr>
<td>L</td>
<td>An alphabetic character, in the range A to Z, is required</td>
</tr>
<tr>
<td>?</td>
<td>Optional letter</td>
</tr>
<tr>
<td>A</td>
<td>Required letter or digit</td>
</tr>
<tr>
<td>a</td>
<td>Optional letter or digit</td>
</tr>
<tr>
<td>&amp;</td>
<td>Required character or space</td>
</tr>
<tr>
<td>C</td>
<td>Optional character or space</td>
</tr>
<tr>
<td>. , ; : ; /</td>
<td>Special characters used as Placeholders and separators</td>
</tr>
<tr>
<td>&lt;</td>
<td>All characters that follow will be converted to lowercase</td>
</tr>
<tr>
<td>&gt;</td>
<td>All characters that follow will be converted to uppercase</td>
</tr>
<tr>
<td>!</td>
<td>Characters will be filled in from left to right</td>
</tr>
<tr>
<td>&quot;Literal text&quot;</td>
<td>Any text in double quotes will be shown as the literal text.</td>
</tr>
<tr>
<td>PASSWORD</td>
<td>The Password input mask creates a password entry box. The password is stored as entered, but displayed as asterisks. For example, ******</td>
</tr>
<tr>
<td>\</td>
<td>Any text that follows the \ will be shown as literal text</td>
</tr>
</tbody>
</table>

Table 6.5 Characters used to define an input mask

### 3.2 Validation rules
- A validation rule is an expression that controls what data will be allowed in a field.
- Data that does not obey the validation rule will not be accepted in that field.
- Rules that apply when working with expressions are:
  - Names of fields must be in square brackets. For example, [Surname].
  - Field names must be spelt exactly as they appear in Design View.
  - Dates must be enclosed in hash signs, for example, #01/01/2010#.
  - Text must be in double quotes. For example, “Brown”.

**Meaning of operators as used in expressions**

<table>
<thead>
<tr>
<th>Operator</th>
<th>Explanation</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>Less than – does not include the criterion in the expression.</td>
<td>&lt;100</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to – includes the criterion in the expression.</td>
<td>&lt;=100</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than – does not include the criterion in the expression.</td>
<td>&gt;0</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to – includes criterion in the expression.</td>
<td>&gt;=50</td>
</tr>
</tbody>
</table>
### Meaning of operators as used in expressions

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to the criterion.</td>
<td>=25</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to the criterion.</td>
<td>&lt;=0</td>
</tr>
<tr>
<td>NOT</td>
<td>Any input, other than the criteria specified, is acceptable.</td>
<td>NOT &gt; 10</td>
</tr>
<tr>
<td>IN</td>
<td>Indicates that values entered in the field should appear in the list. Values in the list must be separated by commas.</td>
<td>IN (&quot;Cape Town&quot;, &quot;Durban&quot;, &quot;Gauteng&quot;)</td>
</tr>
<tr>
<td>BETWEEN</td>
<td>Accept values between two specified criteria. The lower and upper criteria are separated by the AND operator.</td>
<td>BETWEEN 0 AND 100</td>
</tr>
<tr>
<td>LIKE</td>
<td>Stipulates text values to be entered. Can be used with wildcard characters</td>
<td>LIKE &quot;G*&quot;</td>
</tr>
<tr>
<td>IS NOT NULL</td>
<td>Something must be entered in the field.</td>
<td>IS NOT NULL</td>
</tr>
<tr>
<td>AND</td>
<td>Specifies that all the conditions must be met before the data are accepted in the field.</td>
<td>&gt;1 AND &lt;=100</td>
</tr>
<tr>
<td>OR</td>
<td>Specifies that one of the criteria must be a match before data are accepted in the field.</td>
<td>January OR February OR March</td>
</tr>
</tbody>
</table>

Table 6.6: Meaning of operators as used in expressions

- Validation text is the message that is displayed when the data do not comply with the validation rule.

### 4 Queries

A Query is a way of extracting certain data from the table.

#### 4.1 Design basic Queries

- To design a query:
  - Click on the Create tab and select the Query Wizard.
  - Select Simple Query Wizard.
  - From the drop-down menu, choose the table from which to select fields.
  - Choose the fields to insert in the Query.
  - Click Next.
  - Enter a name for the query and click on Finish.

#### 4.2 Displaying fields

To prevent fields from being displayed, remove the tick mark from the Show row in Design View.
4.3 Criteria
When only selected information should be displayed in the query, criteria are used to make the selection.

**Examples of criteria**

<table>
<thead>
<tr>
<th>Example of criteria</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Like “Brown”</td>
<td>Exact text match</td>
</tr>
<tr>
<td>Like “B*”</td>
<td>Text starts with the letter B, followed by any number of characters</td>
</tr>
<tr>
<td>Like “L?”</td>
<td>Text starts with the letter L, followed by any one character</td>
</tr>
<tr>
<td>Like “s”</td>
<td>Text ends with the letter s, any number of characters in front</td>
</tr>
<tr>
<td>Like “d”</td>
<td>Text ends with the letter d, any one character in front</td>
</tr>
<tr>
<td>Not “Dan”</td>
<td>Any text, other than Dan</td>
</tr>
<tr>
<td>“Blue” or “Red”</td>
<td>Value should be equal to Blue or to Red</td>
</tr>
<tr>
<td>1000</td>
<td>Exact match on the value, 1000</td>
</tr>
<tr>
<td>#2/2/2002#</td>
<td>Date in the field should be 2 February 2002</td>
</tr>
<tr>
<td>Between #1/1/2001# AND #10/10/2010#</td>
<td>Any date between 1 Jan 2001 and 10 Oct 2010</td>
</tr>
<tr>
<td>&lt;Date()</td>
<td>Any date before current date</td>
</tr>
<tr>
<td>&lt;#2/2/2002# or &gt;#4/4/2004#</td>
<td>Any date before 2 Feb 2002 and after 4 Apr 2004</td>
</tr>
<tr>
<td>200 or 250</td>
<td>Value should be equal to 200 or 250</td>
</tr>
<tr>
<td>Between 50 and 100</td>
<td>Value between 50 and 100</td>
</tr>
<tr>
<td>&lt;30 or &gt;80</td>
<td>Value smaller than 30 or greater than 80</td>
</tr>
</tbody>
</table>

Table 6.7 Examples of criteria

4.4 AND, OR, NOT logic
- To apply two criteria and both criteria must be met, use an AND operator.
- To apply two criteria and only one of the two criteria should be met, use an OR operator.
- Any criterion that contains the NOT operator in the front, means that all the values, other than the value specified, will display.

4.5 Sorting
- To sort a query in Datasheet View, click on the Ascending or Descending icon on the Home tab in the Sort & Filter group.
- Fields in Design View are sorted in the order in which they appear in the query.
1 Reports
A report is created to print or present data in an attractive way.

1.1 Designing Reports
- To create a report, use the Report Wizard.
- To use the Report Wizard, Select the Create tab and click the Report Wizard icon.
- Select the fields you want on the Report.
- Choose whether you want the information sorted and on which field.
- Choose the layout, page orientation and style.
- Give the Report a name.

1.2 Page headers and footers, report headers and footers
- Page headers print on top of each page.
- Page footers print at the bottom of each page.
- Report headers print once on top of the Report.
- Report footers print once at the bottom of the Report.

1.3 Calculations in Reports
- Calculations should be put in Report footers.
- Use a label and a text box for a calculation.
- Format of a calculation:

\[ \text{=Count}([\text{Class}]) \]

- All functions and formulae start with an equal sign.
- The name of the function.
- A round bracket for the function.
- The name of the field should be in square brackets.
- Close the round bracket.

- Examples of calculations:

<table>
<thead>
<tr>
<th>Number of learners:</th>
<th>=Count([Grade])</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average mark:</td>
<td>=Avg([MathMark])</td>
</tr>
<tr>
<td>Outstanding fees:</td>
<td>=Sum([Outstanding])</td>
</tr>
<tr>
<td>Lowest Science Mark:</td>
<td>=Min([ScienceMark])</td>
</tr>
<tr>
<td>Highest Science Mark:</td>
<td>=Max([ScienceMark])</td>
</tr>
</tbody>
</table>
2 Importing data
- Data can be imported from spreadsheets, text files and other databases.
- Use the Import wizards in the Import group on the External data tab.

3 Exporting data
- Data can be exported to spreadsheets, text files and other databases.
- Use the Export wizards in the Export group on the External data tab.
Unit 4 Integration and problem solving  
(Term 4)

1 Formatting techniques

1.1 Conditional formatting
- To apply conditional formatting:
  - select the Text box or Combo box
  - on the Design tab in the Font group click the Conditional button.
  - to set more than one condition, click Add.

1.2 Form and Report Layout View
- Additional formatting can be set in Layout View.
- Examples of what can be set in the Layout View:
  - Set the margins and spacing between the controls by using control padding.
  - Set the tab order of controls.
  - Adjust the alignment within the control border.
  - Decide where the controls will be displayed on the page.
  - Choose when to display page headers and footers, form headers and footers, report headers and footers, the ruler or the grid.

1.3 AutoFormat
Formats can be selected in Layout view from the Format tab, or in Design View from the Arrange tab in the AutoFormat group.

1.4 List box and Combo box controls
- A list box displays a list of options to choose from.
- The list of options in a combo box are accessed by clicking the drop-down arrow next to it.

2 Integration of database with other packages
- Integration involves using the same data in different application software.
- A database has ways to share data between different software applications.

3 Designing a database for a specific scenario
- Important steps to consider when designing a database include:
  - Define the purpose of the database.
  - Gather all the types of information that the database should contain.
  - Decide how many tables you need and what data types should be used in each table.
  - Decide which field will become the primary key.

4 Problem solving using databases
- Help pages can be accessed by pressing the F1 key on the keyboard.
- Help is available online and offline.
5 Troubleshooting databases
Troubleshooting is a procedure to determine the cause of a problem.

Questions

1.1 You set up a database of all the schools in your community, some of which are part of your district. It contains the fields below.

<table>
<thead>
<tr>
<th>FIELD NAME</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>School_Name</td>
<td>Name of school</td>
</tr>
<tr>
<td>Principal</td>
<td>Name of principal</td>
</tr>
<tr>
<td>Tel_Number</td>
<td>School's telephone number</td>
</tr>
<tr>
<td>Address</td>
<td>School's address</td>
</tr>
<tr>
<td>e-mail_Address</td>
<td>Hotel's e-mail address</td>
</tr>
<tr>
<td>Part_of_District</td>
<td>Whether school is part of the project or not</td>
</tr>
<tr>
<td>School_Fees_Year</td>
<td>School fees per year</td>
</tr>
</tbody>
</table>

1.1.1 Name the field that is most appropriate as a primary key and state why you have chosen this field. (2)

1.1.2 State the most appropriate field type for the School_Fees_Year field. (1)

1.1.3 State the most appropriate field type for the Part_of_District field. (1)

1.1.4 Your friend suggested that you use an input mask for the School_Name field. Give TWO reasons why this is not a practical suggestion. (2)

1.1.5 What feature of a database would you use to generate a list of schools that are NOT part of the district? (1)

2.1 You were asked to create a form using a wizard. Briefly describe what a wizard is. (2)

2.2 The following was entered as criteria for a Query:

\[<100 \text{ and } >150\]

Will these criteria give any results? Motivate your answer. (2)

2.3 The following calculation was entered in the page footer:

\[=\text{AVG ([School_Fees])}\]

Will this calculation work? Motivate your answer. (3)

2.4 Give TWO reasons why a form is a more accurate way of entering data, as opposed to entering it in a table. (2)

3. Explain the use of an input mask in a database by referring to what you would test for in the Tel_Number field. The actual mask is not required. (2)
Answers

1.1 The database:
   1.1.1 Tel_Number OR E-mail address (Any 1)
       A telephone number/e-mail address is unique to a particular hotel.
       NOTE: School_Name – not acceptable (2)
   1.1.2 Currency (1)
   1.1.3 Yes/No
       Boolean (Any 1) (1)
   1.1.4 School names may have different lengths.
       The names may include letters, numbers and other characters in any order. (2)
   1.1.5 Query (1)

2.1 A wizard is a step-by-step guide that helps you to create your own document/form/report. (2)

2.2 No results will be displayed.
       A value cannot be smaller than 100 and greater than 150 at the same time. (2)

2.3 No, the calculation will not work.
       Calculations should be put in the Report footer, not the Page footer.
       The field must be spelt correctly. (3)

2.4 Instructions can be added on what data to enter.
       A form can match a paper form exactly, which will make capturing easier.
       The fields and data types can be restricted to ensure correct data being entered.
       It is easier to work with a form, as opposed to a table.
       Data validation can be used to restrict wrong data being entered. (2)

3. An input mask prevents a user from entering data in an incorrect format.
   The input mask would test for 10 digits that it would be numbers. (2)
SECTION A, Question 5
Your friend needed some data on how the population of South Africa started increasing. After you have done some research you found the dates people started entering South Africa in the 1800’s. He needs some specific information.

5.1 Export the Access table **EnteringSAResearch** to an Excel spreadsheet and save the spreadsheet as **EnteringSAExport**. Ensure all the data is visible in the spreadsheet. (4)

5.2 Edit the database table as follows (6)

<table>
<thead>
<tr>
<th>Exam Paper table</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>AutoNumber</td>
<td>Set as Primary key</td>
</tr>
<tr>
<td>ARRIVAL CAPE TOWN</td>
<td>Date/Time</td>
<td>Long Date</td>
</tr>
<tr>
<td>SHIP NAME</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>PORT OF DEPARTURE</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>NUMBER OF PASSENGERS</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>OTHER PORTS of CALL</td>
<td>Text</td>
<td></td>
</tr>
</tbody>
</table>

5.3 From record number 40 “TEUTON” – remove the “(sank 30th Aug. 1881)”. (1)

5.4 Create an Input Mask for the Arriva Cape Town field so that the date is displayed as follows: DD MMM YYYY. (5)

5.5 Set a Validation Rule for the Number of Passengers field not to allow more than 200 passengers. Add a suitable Validation Text. (3)

5.6 Sort the records in the table descending according to the arrival date. (1)

5.7 Your friend wants to know when the ship Teuton landed in Cape Town. Create a Query based on the table that shows the Teuton ship. Display only the name of the ship and the date. Save the Query as **Ship Query**. (3)

5.8 Create a Query **Plymouth 1881** that displays where the port of departure is Plymouth and the year is 1881. Display the date and the ships’ name. (5)

5.9 Create a Report (based on the table) and save the report as **EnteringSAResearch 26 Report**

5.9.1 Use the following fields: Arrival Cape Town, Ship Name, Port of Departure, Number of Passengers. (2)

5.9.2 Sort the report in ascending order according to the Port of Departure. (2)

5.9.3 The report must be displayed in Landscape. (1)

5.9.4 Do the following calculations in the report:
   a. calculate the total number of Ships (4)

5.9.5 Edit the heading of the report to:
   a. Italics; (1)
   b. 26 pt; (1)
   c. a red font. (1)

5.10 Save the database and close.
## Answers and mark allocation

| 5.1 | Table exported ✓  
All data appears (46 records) ✓  
Spreadsheet saved as EnteringSAExport ✓  
All data visible ✓ | 4 |
| 5.2 | ID – primary key ✓  
Arrival Cape Town – Date/Time ✓, Long Date ✓  
Ship Name – field size 30 ✓  
Port of Departure – field size 25 ✓  
Number of Passengers – number ✓ | 6 |
| 5.3 | Delete “(sank 30th Aug. 1881)” ✓ | 1 |
Spaces correct ✓ | |
| 5.5 | <=200 ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ | 3 |
Suitable validation text ✓ | |
| 5.6 | Sort descending according to date ✓ | 1 |
| 5.7 | Ship Query ✓  
Ship and Arrival in Cape town fields displayed ✓  
Criteria – “Teuton” ✓ | 3 |
| 5.8 | Named “Plymouth 1881” ✓  
Arrival in Cape town and Ship name displayed ✓  
Criteria – Arrival in Cape town – Like “*1881” ✓  
Criteria – Port of departure – “Plymouth” ✓  
And criteria ✓ | 5 |
| 5.9 | Report ✓  
Fields displayed: Arrival Cape Town, Ship Name ✓  
Port of Departure, Number of Passengers ✓  
Report sorted ascending ✓ according to Port of Departure ✓  
Landscape ✓  
In Report Footer ✓ =Count(*) ✓ ✓ Suitable label ✓  
Heading of Report: Italic ✓ 26 pt ✓ red font ✓ | 12 |
In this chapter you will learn about HTML; HTML editor; HTML syntax; basic HTML tags; HTML comments; plain text and text formatting; structure and design of a simple HTML page; good website or webpage design and use of colour; HTML links; HTML images; and HTML lists.
Unit 1 Introduction to HTML (Term 2)

1 Web concepts
- A web browser is a software application that enables users to open and display web pages.
- Some examples of web browsers are Internet Explorer, Mozilla Firefox, Safari and Opera.
- A website is a collection of web pages. Note that the terms website and web page are not the same thing.
- The World Wide Web (WWW) is made up of websites.
- A hyperlink is an electronic shortcut in the form of a word, phrase or image that allows you move from place to place in a document.
- URL stands for Uniform Resource Locator. It is the unique address of a website on the Internet.

2 HTML and HTML editors
- HTML – hypertext markup language.
- HTML uses a set of coded instructions to display the text and graphics of a web page.
- Instructions used in HTML are called markup code.
- Markup code are special characters grouped in sets that mark where formatting changes take effect.
- Each markup code is referred to a tag or HTML tag.
- Markup code defines how the information on the page is presented.
- An HTML editor is a software application for creating web pages.
- Various HTML editors are available, but the commonly used programs are:
  - text editors, such as Notepad
  - WYSIWYG programs use „drag and drop” methods
  - tag editors have a GUI and use HTML coding.

3 HTML syntax and tags
- Syntax is a generally accepted method for the ay language is written.
- HTML has its own syntax called HTML syntax.
- Each markup code is referred to as a tag or an HTML tag.
- An HTML tag tells the web browser how to display the words and images on a web page.
- The web browser does not display the HTML tags themselves, but uses tags to format the content for display.
- Use the file extension .html or .htm to save your web page.

To access or open Notepad
- Click Start
  - ➔ All Programs
  - then ➔ Accessories
  - from Accessories ➔ Notepad
- Notepad is a text editor or source code editor.
3.1 Basic document tags
- Document tags appear in pairs, that is: an opening tag and a closing tag – also called container tags.
- Example of container tags are `<html> </html>`.
- Empty tags do not have an opening and a closing tag, for example, `<b>`.

<table>
<thead>
<tr>
<th>Description</th>
<th>Opening tag</th>
<th>Closing tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML tags are used to open and close a web page.</td>
<td><code>&lt;html&gt;</code></td>
<td><code>&lt;/html&gt;</code></td>
</tr>
<tr>
<td>Head tags come after the open HTML tag. It contains the title tag.</td>
<td><code>&lt;head&gt;</code></td>
<td><code>&lt;/head&gt;</code></td>
</tr>
<tr>
<td>Title tags give the document a title that displays on the title bar.</td>
<td><code>&lt;title&gt;</code></td>
<td><code>&lt;/title&gt;</code></td>
</tr>
<tr>
<td>Body tags contain the text and images of the document with all the other HTML tags that control and format the document.</td>
<td><code>&lt;body&gt;</code></td>
<td><code>&lt;/body&gt;</code></td>
</tr>
</tbody>
</table>

An example of a simple web page, showing the two sections. The dashed box surrounds each section to mark the division between head tags and body tags.

```html
<html>
<head>
<title>Grade 11 CAT web page</title>
</head>
<body>
<h1>Welcome all!</h1>
<p>We are so proud of our first web page.</p>
</body>
</html>
```

3.2 Heading elements: h1 to h6
- An element is everything from the opening tag to the closing tag.
- h1 is a first heading tag and the largest, whereas h6 is a sixth level heading and the smallest.

3.3 Text elements: Paragraphs and break tags
- 'p' is used for paragraphs, for example, `<p></p>`.
- The break tag is an empty tag, for example, `<b>`.
- The break tag forces text to the next line.
- The horizontal rule tag is an empty tag, for example, `<hr>`.
- The horizontal rule tag is used to separate two sections of a web page with a horizontal line across the page.
- The colour and width of the line created by the horizontal rule tag can be changed by adding attributes, such as `color="red"` or `height="15"`.
- Use American spelling 'color' write HTML code for 'colour'.
3.4 Text formatting: bold and italic text tags

- ‘b’ is used for bold, for example, <b></b>
- ‘i’ is used for italics, for example, <i></i>

SG Activity 1

1. Use your Notepad text editor to capture the following HTML code.
2. Save as a web page called MyWeb, for example, MyWeb.html.

```html
<html>
<head>
<title>My web page</title>
</head>
<body>
<h1>h1 to h6 is used for headings 1</h1>
<hr/>The horizontal rule tag creates a line across the page. It is often used to separate two sections of a web page.
<br/>The break tag inserts a blank line.
<p>The paragraph tag will force a new paragraph on the display on the web page</p>
<br/>Remember that the break tag inserts a blank line while the paragraph tag forces text to a new line.
<p><b>The bold tag is placed between the paragraph tags if that whole paragraph is to be bold</b></p>
<p><i>The italics tag is placed between the paragraph tags if that whole paragraph is to be italics.</i></p>
<p><b><i>Paragraph tags are the outermost tags that then contain the bold and the italics tags. Note the order of the opening tags and the closing tags, that is p b i and then i b p. bold</i></p>
</body>
</html>
```
3. View your webpage with your web browser.
4. Write down notes in a notebook on the tags used in this activity.
Answers to SG Activity 1

Check the solution MyWeb_Solution.html in the Solutions folder. It should appear as follows:

<table>
<thead>
<tr>
<th>h1 to h6 is used for headings 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>The horizontal rule tag creates a line across the page. It is often used to separate two sections of a web page. The break tag inserts a blank line.</td>
</tr>
<tr>
<td>The paragraph tag will force a new paragraph on the display on the web page</td>
</tr>
<tr>
<td>The break tag is an empty tag and does not need anything to close it. Remember that the break tag inserts a blank line while the paragraph tag forces text to a new line.</td>
</tr>
<tr>
<td><strong>The bold tag is placed between the paragraph tags if that whole paragraph is to be bold</strong></td>
</tr>
<tr>
<td><strong>The italic tag is placed between the paragraph tags if that whole paragraph is to be italic</strong></td>
</tr>
<tr>
<td>Paragraph tags are the outermost tags that then contain the bold and the italic tags. Note the order of the opening tags and the closing tags, that is p b i and then i b p, bold</td>
</tr>
</tbody>
</table>

4 HTML comment: comment syntax

- Comments are useful for notes to self or others
- Comments are ‘invisible’ to the web browser – the web browser
- Comments can only be viewed in the source code
- Comments can be inserted on multiple lines
- Comment syntax uses an opening and a closing tag.
- Opening Comment <!--
- Closing Comment -->
- For example: <!-- Comments are invisible to the web browser -->

5 Plain text and text formatting tags

- Font tags change the font.
- <font> is used for font: <font> </font>
- Attributes are added to font tags to specify the size and colour of the font.
- Attributes for HTML elements provide additional information about an element.

Rules for using font attributes

- Font attributes are always specified in the opening tag.
- Font attributes do not appear in the closing tag.
- Font attributes are written in form of name="value":
  - name is attribute name
  - value describes the change
- The value is always enclosed in inverted commas.
- For example, <font color="red"> or <font color="purple">Hi there</font>
6 Structure and design of a simple HTML page

- Readers want to find information quickly and read it quickly. For this reason, it is the simple and uncluttered websites that will hold a reader’s attention.
- Most web pages have the following basic layout:

```
<html>
<head>
</head>
<body>
</body>
</html>
```

- The text between `<html>` and `</html>` describes the web page.
- The text between `<head>` and `</head>` will show the title in the title bar of the web page.
- The text between `<body>` and `</body>` is the visible page content.

- All web pages start and end with HTML elements:
  ```html
  <html>
  ... web page ...
  </html>
  ```

- All the other HTML elements will be nested between the opening and closing HTML tags.
- The web page is divided into a Head section and a Body section.
- The Head section begins with the `<head>` opening tag and ends with the `</head>` closing tag.
- The opening body tag `<body>`, is placed immediately after the head tag.
- The closing body tag `</body>`, is typed just before the closing HTML tag.
Unit 2  Web design and more HTML (Term 3)

1 Good website and web page design
- Ask the following questions ...
  - Is the website/page aesthetically appealing?
  - Will the website/page attract the viewer’s attention?
  - Is the website/page appropriate to your target audience?
  - Are the colours of the website/page in harmony?
  - Are users able to find information quickly?
  - Are there links that direct users to more detail?
  - Is the content updated frequently?
  - Does the web page identify the author of the content?
  - Has credit been given for contributions that are not written by the site owner?
  - Are the colours easily visible to people who are visually impaired or colour blind?
  - Is the font size large enough to read on a poor resolution monitor in all light conditions?
  - Does the content of the website/page follow logically, is it clear and to the point?
  - Does the website/page have reasonable margins and space between them?
  - Are there no more than 80 characters of text per line?

2 Use of colour
- Colour is used to enhance a website/page.
- Colour is used to add interest to a website/page.
- Colour can be controlled by the web designer through the use of primary, secondary, and tertiary colours.

2.1 HTML attributes to specify colour

<table>
<thead>
<tr>
<th>Colour attributes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;body bgcolor=#00ffff&gt;</td>
<td>Sets the background colour for the whole page.</td>
</tr>
<tr>
<td>&lt;body text=#00ffff&gt;</td>
<td>Sets the text colour for the whole page.</td>
</tr>
<tr>
<td>&lt;body link=#00ffff&gt;</td>
<td>Sets the unvisited link colour for the page.</td>
</tr>
<tr>
<td>&lt;body vlink=#00ffff&gt;</td>
<td>Sets the visited link colour for the page.</td>
</tr>
<tr>
<td>&lt;body alink=#00ffff&gt;</td>
<td>Sets the activated link colour. Activated link colour as you click on it.</td>
</tr>
<tr>
<td>&lt;font color=#ff0000&gt;</td>
<td>Sets the colour of selected text within a page. The code for red is #ff0000.</td>
</tr>
<tr>
<td>sample text&lt;/font&gt;</td>
<td></td>
</tr>
</tbody>
</table>

3 HTML links
- Every link in HTML has two ends called anchors.
- ‘a’ is used for anchor tags, for example, <a>.
- The source anchor is the location of a link in a web page.
- The destination anchor is the web page to which the link will take the user.
- The opening tag, <a> must contain an ‘href’ attribute.
• The ‘href’ attribute specifies the hyperlink reference and is followed by =URL, where
the URL is the hyperlink destination in double quotation marks.
• Example: <a href=www.google.com></a>.

<table>
<thead>
<tr>
<th>Structure of an HTML link</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Attribute</strong></td>
</tr>
<tr>
<td>&lt;a href</td>
</tr>
<tr>
<td>&quot;<a href="http://google.com%22%3E">http://google.com&quot;&gt;</a></td>
</tr>
<tr>
<td>A link to Google</td>
</tr>
<tr>
<td>&lt;/a&gt;</td>
</tr>
</tbody>
</table>

4 HTML images

4.1 Align, height, width, vspace and hspace attributes
• Image controls are added to control the alignment, height, width, horizontal space
and vertical space around the image.
• Examples:
  <img src=xlogo.gif align="left">
  <img src=xlogo.gif height="400" width="300">
  <img src=xlogo.gif hspace="50" vspace="60">

<table>
<thead>
<tr>
<th>Attributes of image tags</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>align = left</strong></td>
</tr>
<tr>
<td><strong>align = right</strong></td>
</tr>
<tr>
<td><strong>align = top</strong></td>
</tr>
<tr>
<td><strong>align = bottom</strong></td>
</tr>
<tr>
<td><strong>align = middle</strong></td>
</tr>
<tr>
<td><strong>Height = 200</strong></td>
</tr>
<tr>
<td><strong>Width = 220</strong></td>
</tr>
<tr>
<td><strong>Hspace = 100</strong></td>
</tr>
<tr>
<td><strong>Vspace = 75</strong></td>
</tr>
<tr>
<td><strong>Vspace = 75</strong></td>
</tr>
<tr>
<td><strong>Vspace = 75</strong></td>
</tr>
<tr>
<td><strong>Vspace = 75</strong></td>
</tr>
</tbody>
</table>

4.2 Alternative text attribute
• The alternative text attribute <alt> is added so that the web page loads quickly, |
because it will display text and not a graphic, for example.
• The ‘alt’ attribute can be added to the image tag to provide a text alternative that will |
display instead of the image.
• Example: `<img src=xlogo.gif alt="no logo">`.

4.3 Border attribute
• A border attribute can add an image around a border, or specify no border.
• By default, the image will be displayed with a thin border.
• To change the thickness of the border, or to turn the border off, you have to set the value of the pixels of the border.
• Examples of an image tag with the border attribute:
  • `<img src=xlogo.gif border="0">`
  • (border=0 will turn the border off).

5 HTML lists
• `'ol'` is used to specify an ordered list or numbered list.
• `'ul'` is used to specify an unordered list or bulleted list.
• HTML bullets display as a disc, circle or square, but they can be customised to other symbols.
• Each listed item must be coded as `<li>` so that it appears on a new line.

<table>
<thead>
<tr>
<th>HTML lists</th>
<th>Opening tag</th>
<th>Closing tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numbered list</td>
<td><code>&lt;ol&gt;</code></td>
<td><code>&lt;/ol&gt;</code></td>
</tr>
<tr>
<td>Bulleted list</td>
<td><code>&lt;ul&gt;</code></td>
<td><code>&lt;/ul&gt;</code></td>
</tr>
<tr>
<td>List items</td>
<td><code>&lt;li&gt;</code></td>
<td><code>&lt;/li&gt;</code></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Attributes of list tags</th>
<th>Description</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type = A</td>
<td>Upper case alphabetic letters</td>
<td>A, B, C, ...</td>
</tr>
<tr>
<td>Type = a</td>
<td>Lower case alphabetic letters</td>
<td>a, b, c, ...</td>
</tr>
<tr>
<td>Type = I</td>
<td>Upper case roman numerals</td>
<td>I, II, III, ...</td>
</tr>
<tr>
<td>Type = i</td>
<td>Lower case roman numerals</td>
<td>i, ii, iii, ...</td>
</tr>
<tr>
<td>Type = 1</td>
<td>Numbers</td>
<td>1, 2, 3, ...</td>
</tr>
</tbody>
</table>
Questions

Question 1

1.1 Who sets the standards for web pages?
   A Microsoft
   B World Wide Web Consortium
   C Mozilla
   D LibreOffice

1.2 HTML is NOT a …
   A commonly accepted standard of coding to display website content
   B language to specify the format and layout of web pages
   C coding language
   D computer programming language

1.3 Which tag would you use for a numbered list in HTML?
   A <li>
   B <ul>
   C <list>
   D <ol>

1.4 Which ONE is the correct HTML for creating a hyperlink?
   A <a>http:www.google.com</a>
   B <a href="http:www.google.com"></a>
   C <a url="http:www.google.com"></a>
   D <a name="http:www.google.com"></a>

(4 x 1)= [4]
Question 2

Write only the letter of the answer that you select from Column B in the ANSWER column next to the statement given in Column A.

<table>
<thead>
<tr>
<th>Column A</th>
<th>ANSWER</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Software designed to create webpages</td>
<td>A</td>
<td>standards</td>
</tr>
<tr>
<td>2 The arrangement of words in a sentence</td>
<td>B</td>
<td>&lt;hr/&gt;</td>
</tr>
<tr>
<td>3 The World Wide Web (WWW) is made up</td>
<td>C</td>
<td>container tags</td>
</tr>
<tr>
<td>4 A program designed to read and interpret HTML</td>
<td>D</td>
<td>text editor</td>
</tr>
<tr>
<td>5 Tags that have both an opening and a closing are called</td>
<td>E</td>
<td>&lt;href&gt;</td>
</tr>
<tr>
<td>6 An HTML tag that creates a horizontal line</td>
<td>F</td>
<td>HTML editor</td>
</tr>
<tr>
<td></td>
<td>G</td>
<td>websites</td>
</tr>
<tr>
<td></td>
<td>H</td>
<td>empty tags</td>
</tr>
<tr>
<td></td>
<td>I</td>
<td>syntax</td>
</tr>
<tr>
<td></td>
<td>J</td>
<td>web pages</td>
</tr>
<tr>
<td></td>
<td>K</td>
<td>web browser</td>
</tr>
</tbody>
</table>

(6 x 1) = [6]

Question 3

3.1 The paragraph tag <p> inserts a blank line space on a web page. (2)
3.2 The destination anchor is the web page to which the link will take the user. (2)
3.3 The web browser will NOT display comments created in comment tags. (2)

[6]

Question 4

4.1 Other than a text editor, name two types of HTML editors. (2)
4.2 Explain the term HTML element. (2)
4.3 Explain what an attribute is and give one example of an attribute. (3)
4.4 What type of file extension would be best for inserting clipart or other simple images in a webpage? (1)
4.5 Give ONE consideration for making the appearance of colours more „powerful” on your site. (1)

[9]
Question 5

Retrieve the incomplete HTML file called MySport.

4.1 Add an orange background colour to the web page. (2)
4.2 The text “tennis, soccer, swimming” must appear in a bulleted list. The bullets must be square-shaped bullets. (2)
4.3 Add the image called Spain.jpg
   4.3.1 The height of the image must be 200 (6)
   4.3.2 Place a thick line border around the image

TOTAL :35

Answers to Questions

Answers to question 1

1.1 B ✓
1.2 D ✓
1.3 D ✓
1.4 B ✓ [4]

Answers to question 2

2.1 F ✓
2.2 I ✓
2.3 G ✓
2.4 K ✓
2.5 C ✓
2.6 B ✓ [6]

Answers to question 3

3.1 FALSE ✓ – The break tag ✓ inserts a blank line. (2)
3.2 FALSE ✓ – The source anchor is the web page to which the link will take the user/is the location of a link in a web page. ✓ (2)
3.3 TRUE ✓✓ (2)

[6]
### Answers to question 4

4.1 Tag editors ✓ and WYSIWYG programs ✓

4.2 An **element** is everything ✓ from the opening tag to the closing tag. ✓

4.2 **Attributes** are extra properties ✓ that are added to the opening tag ✓, such as colours ✓, alignment or heading sizes.

4.3 .JPG ✓

4.4 Limit the use of colour. ✓

### Answers to question 5

5.1 Background colour has been added to the web page.

   ```html
   <body bgcolor="orange"> ✓ ✓
   ```

5.2 Attribute (for square bullets) is added to unordered list tag

   ```html
   <ul type="square"> ✓ ✓
   ```

5.3 Image tag with its attributes are added:

   ✓ ✓ ✓ ✓ ✓ ✓

   ```html
   <img src=Spain.jpg width="200" border="5">
   ```

TOTAL: 35
Chapter 8 Information management and the PAT

Overview

This chapter will introduce you to information management skills. Information management helps you to solve a problem by accessing and processing data. Once you have processed the data, you will be required to present the information as a report written in a word processing application. In addition, you will have to prepare a presentation, either in the form of a slide show or as a web page. In this chapter you will learn about the difference between data and information; understanding a problem and using problem-solving techniques; the role of questions and questioning to determine information needs; information sources and data gathering tools; how to find and access information; information sifting to keep only information that solves a problem; knowledge and insight in decision-making; manipulating information; handling data using spreadsheets and databases; processing data; presenting information using a word processor, a presentation application or web design.
Unit 1 Gathering and managing information
(Term 2)

1 PAT Phase 1
1.1 Information management concepts
- Managing information involves gathering, selecting, organising and interpreting data, and presenting processed data as information.
- Data is a collection of raw, unevaluated facts, such as numbers, text, images, audio and video.
- Once data is processed, it becomes information.
- The PAT is an information management and research project consisting of three phases:
  - Phase 1 – data gathering.
  - Phase 2 – data manipulation.
  - Phase 3 – presenting information in a report and presentation (slide show or web page).

Gather data
- Gathering data starts with an understanding of why you want the data.
- Start by asking questions designed to identify the problems associated with the PAT.
- Asking questions defines the problem and helps to identify the data you must look for.
- Identify possible sources of data and information. Choose a variety of sources to gather data.
- One source must be a questionnaire that you compile and give to a small sample of people.

Select, organise and interpret information
- Once you have collected data, you need to process it to make it meaningful.
- Use a spreadsheet to process and analyse the data you obtained from the questionnaire to show trends and patterns.
- Use a database to generate queries and provide reports after you record the information you have gathered.

Present information
- A report prepared in a word processing application. The report outlines the problem and recommends a course of action to solve or improve the problem.
• A slide show presentation, or a web page, to summarise your report for your target audience.

1.2 Task definition and data gathering
• The task definition will determine the type of data you gather.
• Fully understanding the task requirements makes easier to identify sources of information.
• Make a big task manageable by breaking the task down into smaller parts.
• Start with planning and creating a set of folders to store the information.

Understanding the task requirements
• Understand exactly what is expected of you.
• Follow the PAT instructions very carefully, and then write a task definition.
• A task definition specifies the problem you have to solve, who it is for, what information you need to find, and how and where you will find it.
• In essence, you need to answer questions such as:
  • What do I know about the topic or problem?
  • What information is missing or needed?
  • Where and how can you find information you still need?

Identifying problems associated with the topic
• After defining the task, you can brainstorm the topic with a group of classmates to find ideas for possible headings.
• Select headings that will be useful in helping to organise the material.
• Ask questions that relate to the topic such as:
  • Questions that lead to factual information – Level 1 questions starting with words such as: What? When? Where? Who? How many?
  • Questions that explore – Level 2 questions that start with Why? or How?
  • Questions that predict – Level 3 questions that start with If? or What if?
  • Questions that help make judgments – Level 4 questions that will help you to reach a conclusion. They start with phrases such as: Would it be better if? How can I determine? What would be the best way?
• When you have your list of questions, arrange them according to headings that you have identified for the main parts of the topic.
• You can write questions under each sub-topic or simply write down questions and arrange them under each sub-topic at a later stage.
• As you work with your questions and headings, you may identify and add new headings or remove existing headings. See this as part of the process of refining your methods.

Possible sources of information
• Once you have defined the task you need to consult a variety of sources, in both printed and electronic media, including:
  • Publications: books, newspaper articles, magazines and brochures.
  • Electronic media: the Internet, including encyclopaedias and social networks, etc.
  • Interviews: prepare questions in advance and take notes of the interviewees” responses.
  • Surveys are useful tools to find out more about people’s attitudes and circumstances.
• The way your questions are asked will determine the quality of the information you receive.
**Gather information**
Think of ways to find the information that you need for your investigation. Remember, you need more than you will use for the final report. Find different ways to source data and information on your own. Alternatively, work in a group to find possible ways of solving the problem.

**1.3 Quality control techniques**
- Not all information is reliable. Information, whether it is electronic or printed, may be biased. It is good practice to access more than one source of information to allow you to compare the information you find. Aspects to check include:
  - Authority – who created the information?
  - Accuracy – can the statements and claims be substantiated?
  - Currency – is the information up-to-date, and is it still relevant?
  - Objectivity – does the source/author show any bias?
  - Coverage – how well does the information cover the topic?

**Evaluate a website**
- Use the following criteria to help you assess the reliability of websites:
  - Affiliation – who supports the website?
  - Audience – at what level it is written/who is it intended for?
  - Authority/the author – who created the website and what are their credentials? Use a search engine to find more information on the authors.
  - Content – is the content properly organised? Do the links work?
  - Current – is the information on the web page up to date or still relevant?
  - Design – is it easy to navigate and is it visually pleasing?
  - Objectivity – does it reflect any preconceptions?
  - Trustworthy – Would you be able to use it?

**Sifting information**
Go through the available information on websites and other sources and select the most relevant.

**Role of surveys and questionnaires**
- The PAT usually includes instructions for a survey that you need to conduct by asking people to respond to questions in a questionnaire.
- Keep the completed questionnaires that you have collected, because they form an important part of the information that you need for completing the PAT.
Unit 2  Processing information (Term 3)

PAT Phase 2
- Phase 2 of the PAT involves processing the data collected.
- Organise and interpret the data you have collected with the help of:
  - a spreadsheet
  - a database to process questionnaire responses and generate queries and reports.

1.1 Manipulate data: spreadsheet and database
- You need to have insight into the problems raised in the PAT.
- Compare the data and identify the relationships between them.
- The information presented in your report must show your audience how your proposals will improve matters and solve problems.

Processing data using spreadsheets
- Group and sort your data with the use of a spreadsheet to:
  - identify the core meaning and the most important aspects
  - summarise the information and add your own insights
  - create charts and tables to make the material more understandable.
- The questionnaire results that you analyse in a spreadsheet are a sample of the responses obtained from the survey you did.
- Questions that often arise when you work with data samples include:
  - How many?
  - What occurs the most?
  - What is the most popular?
  - What is least common?
  - How many more than?
  - What is the average?
- Spreadsheet functions that you could consider using include:
  - COUNTA, COUNTIF, IF, and SUMIF.
- Other useful functions might be:
  - CONCATENATE, LOOKUP, AND, NOT, MIN, MAX, and AVERAGE.

Processing data using a database
- Create a database with the information you have gathered so that you can generate queries and provide database reports.
- Verify that the information is relevant to the investigation by:
  - Capturing data that could be used to answer your questions
  - Using appropriate field names and data types.
  - Creating queries and providing a database report.
- You will need to have data in a database table, so will either have to export from the spreadsheet and import into the database, or capture it directly into the database.
- Use the information from your database queries and reports in your word processing report and the slide show or web page.
• The queries should help you to find information to solve the problem or, at the least, to make some recommendations.
• Generate one query with four or five criteria instead of running four or five different queries.
• Use the wildcard character (*) for queries.
• Use the filter to help you identify criteria for your query.
• Use additional features provided by the database, such as validation rules for accuracy of data capture, and grouping and calculations in the group footers.
• Use queries and present your data in the form of a database report.
• A word processing report reads almost like an essay, and a database report gives statistical information to a reader.

1.2 Practical application of skills and concepts
• Use spreadsheet formulas and functions to determine how many responses meet a certain criterion.
• Prepare a chart from the statistics.
Unit 3  Presenting information (Term 4)

1 PAT Phase 3
- The last phase of the PAT brings all your findings and supporting documents together in a report and a presentation.
- The solutions and recommendation must be put forward to solve the problem posed.

1.1 Using applications to finalise PAT
- A report is a document that gives information about an investigation or research done.
- It should include analysis, evaluations and recommendations.
- When you are asked to write a report, you will be expected to:
  - Analyse the information that you were given initially.
  - Find more information by reading books, visiting websites or consulting other sources relevant to the investigation.
  - Draw conclusions from the facts presented.
  - Make recommendations, persuade or give an opinion.
  - End with a conclusion.
- The structure of a report is usually as follows:
  - Title page – topic, author’s name and date on which the report was written.
  - Table of Contents – generate an automatic Table of Contents.
  - Introduction – outline the task definition and the reason for the investigation.
  - Body paragraphs – use main headings and subheadings to organise themes and present the information in a logical way.
  - Recommendations or findings – say how the problem may be solved or how the situation can be improved; make recommendations.
  - Conclusion – draw all the main points together to present an overview.
  - Bibliography or list of references – use the Harvard or APA (American Psychological Association) method.

Copyright and plagiarism
- Information that has been published, whether electronically or in print, is protected by copyright law.
- If you copy or quote information from another source you must acknowledge the source.
- Using the work of other people and not citing the source is plagiarism.

1.2 Practical assessment task: Final phase
The final phase of the PAT is to present your work to your target audience.
- The form in which you present it will be:
  - a word processing report
  - a slide show presentation, or a web page.
## Questions

1. Differentiate between data and information. (4)
2. How will a task definition assist the research process? (2)
3. Discuss four types of questions that should be used to get information on the issue or problem on hand. (8)
4. Name and explain two sources of information. (4)
5. Discuss three criteria you would use to evaluate a website. (6)
6. Discuss three criteria to help you assess the reliability of websites. (6)
7. Outline the structure of a report. (7)
8. Explain the term "plagiarism". (2)
9. What law protects published work? (1)

**TOTAL : 40**
Answers to questions

1. Data is a collection of raw, unevaluated facts, such as numbers, text, images, audio and video. Once data is processed, it becomes information. (4)

2. The task definition adds focus and guides the research process. (2)

   Questions that explore – Why? or How?
   Questions that predict – If? or What if?
   Questions that help make judgments – Would it be better if? How can I determine? What would be the best way? (8)

4. Publications: books, newspaper articles, magazines and brochures. Electronic media: the Internet, encyclopaedias and social networks, etc.
   Interviews: questions to get interviewees’ responses
   Surveys: useful tools to find out about people’s attitudes and circumstances. (any 2 x 2) = (4)

5. Authority – who created the information? Accuracy – can the statements and claims be substantiated? Currency – is the information up-to-date, and is it still relevant? Objectivity – does the source/author show any bias? Coverage – how well does the information cover the topic? (any 3 x 2) = (6)

6. Affiliation – who supports the website? Audience – at what level it is written/who is it intended for? Authority/the author – who created the website and what are their credentials? Use a search engine to find more information on the authors.
   Content – is the content properly organised? Do the links work?
   Current – is the information on the web page up to date or still relevant?
   Design – is it easy to navigate and is it visually pleasing?
   Objectivity – does it reflect any preconceptions?
   Trustworthy – Would you be able to use it? (any 3 x 2) = (6)
7 Title page ✓
   Table of Contents ✓
   Introduction ✓
   Body paragraphs ✓
   Recommendations or findings ✓
   Conclusion ✓
   Bibliography or list of references ✓

8 Using the work of other people ✓ and not citing the source is plagiarism. ✓

9 copyright ✓

TOTAL: 40
**Practical Examination – Paper 1**

**Time: 50 Minutes**

<table>
<thead>
<tr>
<th>Question</th>
<th>Suggested time</th>
<th>Marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question 1</td>
<td>Word Processing</td>
<td>36 minutes</td>
</tr>
<tr>
<td>Question 2</td>
<td>Word Processing</td>
<td>16 minutes</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td>50 minutes</td>
<td><strong>50 marks</strong></td>
</tr>
</tbody>
</table>

To answer this paper your **SG_DataFiles** folder - Practical Exam P1, should contain the following folders/files:

- 1Brochure.docx
- 1Map.docx
- 2Members.xlsx
- 2Special.docx
- SAFlag.jpg

**Scenario**

Freedom Tourism Services is aimed at meeting tourist requirements and expectations and offers a variety of services to tourists who want to experience the heart of Africa. As part of the team at Freedom Tourism Services you will be expected to assist with the administrative and financial matters. The services provided by Freedom Tourism Services include:

- flight bookings
- car hire
- accommodation
- guided tours

**Question 1 - Word processing**

A brochure has been drafted for distribution. Make formatting changes to complete the design of this brochure.

Open the file **1Brochure**.

Study the examples to help you edit the document as instructed. Note that your document should appear similar to the screenshots of page 1 and page 4.
1.1 Fully justify the text in the document. (1)

PAGE 1

World Heritage Sites in South Africa

TABLE OF CONTENTS

WHAT ARE WORLD HERITAGE SITES (WHIS)? ......................... 1
South Africa's World Heritage Sites ..................................... 1

INFORMATION SUPPLIED BY FREEDOM TOURISM SERVICES 4
Current Exchange Rates ..................................................... 4

Message from Nelson Mandela
(Addresses 10 May 1994)

"I believe that South Africa is the most beautiful place on earth. Admittedly, I am biased, but when you combine the natural beauty of South Africa with the friendliness and cultural diversity of our people, and the fact that the region is a haven for Africa's most splendid wildlife, then I think even the most scrupulous critic would agree that we have been blessed with a truly wonderful land. I would like to extend a personal invitation to you to come and see for yourself the splendour of South Africa. I know that my people will be delighted to welcome you and I think you will be enchanted by their warmth and hospitality. I am equally sure that you will enjoy our culture, our cuisine and the warmth of our people." (South

1.2 Insert the title 'World Heritage Sites in South Africa' in the header at the beginning of the document as shown in the example.
- The title must appear on the first page only.
- Use WordArt for the text with a size of 1.37 cm x 24.6 cm.
- Fill the WordArt shape with the picture which is saved as SAFlag.jpg. (4)

1.3 Insert an automatically generated table of contents to appear in the first column under the heading 'TABLE OF CONTENTS' as shown in the example.
- Page numbers are right-aligned - do not show them as hyperlinks.
- Only level 1 and level 2 headings are displayed. (4)

1.4 Format the picture of Nelson Mandela as follows:
- Combine the picture and the caption so that it can be moved as one object. (1)
- Use a text wrapping style to wrap the text around all sides of the picture. (1)

1.5 Link the words (South Africa Travel, 1999) in the third column to the bookmark 'BIBLIOGRAPHY' on the last page of the document. (1)
1.6 Change the bulleted list in the document to a numbered list.

1.7 Format the 'T' of 'The .....' in the last paragraph (column 3) to be a dropped capital letter 2 lines deep.

Note the positioning and the shading of the dropped cap in the example.

1.8 Starting from the second page, insert automatic page numbering to appear in the right-hand corner of the header in any format of your choice.

**PAGE 4**

8. Vredefort Dome
Location: Free State, South Africa

The Vredefort dome is the oldest and largest meteorite impact site in the world. It was formed approximately 2 million years ago when a gigantic meteorite hit the earth close to Vredefort. The ring of hills that one can see now is the eroded remains of a dome created by the rebound of the rock below the impact site.

**INFORMATION SUPPLIED BY FREEDOM TOURISM SERVICES**
Click on this link to view a map of South Africa and to locate the heritage sites. (link)

Use the drop-down menus below to browse through our list of options:
How to find accommodation to suit your preferences: Family Friendly!

South African books available from Amazon: SA Travel Books
Select the province or region you plan to visit: Western Cape

**Current Exchange Rates**
Currency exchange rates are available at banks and published in the press.
**Notes issued:** R200, R100, R50, R20, R10, coins R5, R2, R1, 50c; 20c, 10c.

<table>
<thead>
<tr>
<th>Foreign Currency to SA Rand</th>
<th>Current Exchange Rates</th>
<th>Exchange Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>USD 1.00 = 10.10 ZAR</td>
<td>US Dollar (USD)</td>
<td>12.93</td>
</tr>
<tr>
<td>GBP 1.00 = 15.00 ZAR</td>
<td>Pound Sterling (GBP)</td>
<td>15.00</td>
</tr>
<tr>
<td>EUR 1.00 = 13.73 ZAR</td>
<td>Euro (EUR)</td>
<td>13.73</td>
</tr>
<tr>
<td>AUD 1.00 = 8.43 ZAR</td>
<td>Australian dollar (AUD)</td>
<td>8.43</td>
</tr>
<tr>
<td>INR 1.00 = 0.15 ZAR</td>
<td>Indian Rupee (INR)</td>
<td>0.15</td>
</tr>
<tr>
<td>JPY 1.00 = 0.19 ZAR</td>
<td>Yen (JPY)</td>
<td>0.19</td>
</tr>
<tr>
<td>SGD 1.00 = 5.40 ZAR</td>
<td>Singapore dollar (SGD)</td>
<td>5.40</td>
</tr>
</tbody>
</table>

**Bookmark and share this information.**
You name it, we can communicate it!

**BIBLIOGRAPHY**

1.9 Adjust the page orientation and margins of page 4 to be the same as the previous pages.

1.10 Place the text from 'Vredefort Dome …’ to the end of page 4 in columns as follows:
- 3 columns
- Vertical line between the columns.
1.11 The hyperlink (htt) currently links to the file _SAFlag_.

Change the properties of the hyperlink so that the hyperlink links to the file _1Map_. (2)

1.12 Add the provinces 'Gauteng' and 'Free State' to the drop-down list in the first column at 'Select the province …' (2)

1.13 Ensure that the first paragraph, starting with the heading 'Current Exchange Rates', starts at the top of the second column. (1)

1.14 Convert the text (yellow shading) to a table.
   - This table must fit to the contents and appear in the second column as shown in the example. (4)
   - Replace the yellow shading with an orange background colour.

1.15 Format the third column to resemble the example. (2)

1.16 Add an automatic built-in bibliography under the heading 'BIBLIOGRAPHY' to list the sources cited in the document. (2)

1.17 Switch the endnote in the document to a footnote. (1)

1.18 Add a light green background colour to the document. (1)

Save and close the file _1Brochure_. [36]
**Question 2 - Word processing**

The management of Freedom Tourism Services have organised a competition for their members.

Open the file *2Special*. Study the image below and then follow the instructions to complete the form. This form will also be used as the main document for a mail merge.

2.1 The text *'FREEDOM TOURISM SERVICES OFFERS YOU SOMETHING SPECIAL!'* which appears at the bottom of the page, must be:

- Moved and inserted in a left-aligned sidebar (Alphabet Sidebar).
- The sidebar must be filled with a light green background. (3)

2.2 Insert a date field in line with the heading 'DATE:'

The date must:

- Be in the format MM-DD, for example Feb-12 (2)
- Update automatically.
2.3 Insert a check box form field to the left of the word 'English'.

2.4 The paper size of this document must be A5.

2.5 Set editing restrictions to this document allowing the user to fill in the form only. DO NOT use a password.

2.6 Use the spreadsheet data **2Members** to prepare the **2Special** document for a mail merge.
- This competition is only available to members who have been members for five years or more.
- Add the merge field names *Name*, *Surname*, and *Membership number* next to the corresponding heading.
- Sort the members in descending order of their membership number.

Save the document as **2Prem** before performing the mail merge.

2.7 Complete the mail merge, saving the results to a new document called **2Merge**.

Save and close the documents **2Special**, **2Prem** and **2Merge**.
Section A

Question 1

Various options have been provided as possible answers to the following questions. Choose the most appropriate answer and write down ONLY the letter (A – D) next to the question number (1.1 – 1.10) e.g. 1.11 D.

1.1 Which ONE of the following applications would be most suitable to create a invoice that would calculate amounts automatically?
   A Spreadsheet
   B Word processor
   C Database
   D None of the above (1)

1.2 Which ONE of the following is NOT part of the information processing cycle?
   A Input
   B Output
   C Storage
   D All of the above are part of the information processing cycle. (1)

1.3 Which ONE of the following is the largest mobile computing device?
   A Tablet
   B Smart phone
   C PDA
   D All of the above are the same size (1)

1.4 Which ONE of the following computers are the most powerfull?
   A Mainframe
   B Gaming PC
   C Supercomputer
   D Laptop (1)
1.5 Which function would you use to count together only certain numbers in a range?
   A SUM
   B COUNT
   C COUNTIF
   D CERTAINCOUNT (1)

1.6 Which ONE of the following devices would be used to provide a constant supply of electricity in the case of a power failure?
   A Surge protector
   B UPS
   C Power Supply Unit
   D None of the above (1)

1.7 Which ONE of the following is NOT a wireless connection?
   A USB
   B Wi-Fi
   C Bluetooth
   D Infrared (1)

1.8 Which ONE of the following components would have the greatest influence on the speed of a computer?
   A RAM
   B Hard drive
   C Motherboard
   D CPU (1)

1.9 Quality of a printout is measured in
   A Resolution
   B dpi
   C MHz
   D GB (1)

1.10 Which ONE of the following extensions would indicate a picture?
    A jpg
    B mp3
    C docx
    D pic (1)
**Question 2**

In each of the following cases indicate whether the statement is TRUE or FALSE. If the statement is FALSE then rewrite the statement in order for it to be TRUE.

2.1 A file attribute of hidden means that the file can not be edited and saved again. (1)
2.2 Operating systems are used to communicate instructions from an application to the hardware. (1)
2.3 A LAN is prone to dropping connections. (1)
2.4 Fibre optic is usually used to connect an antenna to your television. (1)
2.5 A router is used to connect two different networks. (1)

**Question 3**

Choose an item/word from COLUMN B that matches a description in COLUMN A. Write only the letter (A – O) next to the question number (2.1 – 2.10), for example 2.11 Q.

<table>
<thead>
<tr>
<th>COLUMN A</th>
<th>COLUMN B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Physical connection between a computer and a communication medium such as a cable</td>
<td>A bps</td>
</tr>
<tr>
<td>2. The central wiring point of a network</td>
<td>B FTP</td>
</tr>
<tr>
<td>3. Unit in which data transmission is measured</td>
<td>C Retina</td>
</tr>
<tr>
<td>4. Software distributed with embedded advertisements</td>
<td>D GHz</td>
</tr>
<tr>
<td>5. Protocol to transfer files over the Internet</td>
<td>E Input mask</td>
</tr>
<tr>
<td>6. An example of a dedicated computer</td>
<td>F NIC</td>
</tr>
<tr>
<td>7. Way of checking for data validity in a database</td>
<td>G Webcam</td>
</tr>
<tr>
<td>8. Device used to convert a hard copy to a soft copy</td>
<td>H Adware</td>
</tr>
<tr>
<td>9. Example of a biometric feature used for security</td>
<td>I Switch</td>
</tr>
<tr>
<td>10. Terminal used in a shop to sell items</td>
<td>J RAM</td>
</tr>
<tr>
<td></td>
<td>K Scanner</td>
</tr>
<tr>
<td></td>
<td>L POS</td>
</tr>
<tr>
<td></td>
<td>M ATM</td>
</tr>
<tr>
<td></td>
<td>N UTO</td>
</tr>
</tbody>
</table>
Section B

All of the questions in this section are based on the scenario below:

**Scenario**

The local council would like to get more tourists to visit your area. As part of the project they would like to involve your school in the project. Your CAT class will be handling all of the computer related issues throughout the project such as creating posters, flyers, keeping records and having a database of all contact details. Answer the questions contained in this question paper to help with the project.

Mr. Gobig from the local council will be your contact person and Mrs. Thinkwell from the school will be in charge of the project on the school side.

**Question 4**

**System technologies**

Mr. Gobig has some questions regarding computers and software that he will be buying for the council. Answer the following questions to help him buy the correct software:

4.1 Briefly explain to Mr. Gobig what an embedded computer is. (2)
4.2 Mr. Gobig will be upgrading his cell phone contract at the end of the year, and has been offered a smart phone:
   4.2.1 What is the main difference between a cell phone and a smartphone? (1)
   4.2.2 Name TWO features commonly found on a smartphone. (2)
4.3 Mrs. Thinkwell would like to buy a tablet that she can use while on the move.
   4.3.1 What item does a tablet use in the place of a keyboard and mouse? (1)
   4.3.2 Name TWO advantages of using the device in the previous question. (2)
4.4 While installing one of the hardware devices you realise that you have lost the original installation discs containing the drivers.
   4.4.1 What are drivers? (2)
   4.4.2 Name TWO possible ways in which you could get the drivers. (2)
4.5 What does the term troubleshooting mean? (2)
4.6 Describe troubleshooting techniques that you would follow in each of the following cases:
   4.6.1 A printer does not work even though it is switched on. (2)
   4.6.2 A flash drive is not shown on the file explorer application. (2)
4.7 Discuss the function of a CPU, keyboard, monitor and hard drive within the information processing cycle. (4)
4.8 Describe the difference between the function of a client, server and peer. (3)

[25]
Question 5

Internet and network technologies

Mr Gobig would like to connect the existing computer and the new computer in a network. This will cost some money to do but he reckons the advantages would outweigh the cost. Answer the following questions regarding installing the network:

5.1 Installing a network will result in a multitude of advantages such as sharing expensive computing devices. List TWO more advantages of installing a network.

5.2 Discuss the function of each of the following devices in a network:

5.2.1 Proxy server (1)
5.2.2 NIC (1)
5.2.3 Firewall (2)
5.2.4 Switch (1)

5.3 Compare wired and wireless networks (LAN and WLAN) under the following headings:

5.3.1 Installation cost. (2)
5.3.2 Speed (2)
5.3.3 Security (2)
5.3.4 Connection in difficult locations (2)

Question 6

Information management

Mr. Gobig want to know what each of the following data types mean in his database. Write down a short description of each:

6.1 Text
6.2 Memo
6.3 Number
6.4 Date/Time
6.5 Currency
6.6 Yes/No
6.7 OLE Object (Object Linking and Embedding)
6.8 Hyperlink
6.9 Attachment
6.10 AutoNumber

[10]
Question 7

Social implications

Answer the following questions to help Mr. Gobig with any queries he has regarding the social implications of using a computer on a regular basis:

7.1 Explain to Mr. Gobig how he could enhance accessibility on the computers under each of the following headings by naming TWO examples of each:
   7.1.1 Screen settings.  
   7.1.2 Keyboard settings.  

7.2 Briefly explain to Mr. Gobig what the difference is between a screen reader and a screen magnifier.

7.3 Name TWO ways in which Mr. Gobig can save on electricity usage without investing in new hardware.

7.4 How could Mr. Gobig prevent any health related issues when working in front of a computer?

Question 8

Solution development

Mr. Thinkwell will be handling most of the responsibilities with regards to administration. She has a few questions regarding the applications she would be using:

8.1 Mention the cause of each of the following error messages in a spreadsheet as well as a possible way of solving the error:
   8.1.1 #######  
   8.1.2 #NUM!

8.2 Which feature within a database application would you recommend Mrs. Thinkwell use in each of the following cases?
   8.2.1 Retrieving specific information from within a table.  
   8.2.2 Entering data easily into a table without accessing the table itself.  
   8.2.3 Finding data in a table without saving the result.

8.3 Name THREE examples of ways in which you can ensure accurate data input within a database table.

8.4 Study the screenshot below and then write down functions or formulas that you would use for the questions that follow:
8.4.1 Finding the amount that an item has sold (column E) more or less than the reserve price in column D.  (2)

8.4.2 Which function would you use in cell F12 to find the total amount of values in column F that are below 0, where an item was sold for less than the reserve price.  (3)

Question 9

Integrated scenario

Mr. Gobig would like to buy a computer for you to use exclusively for the tourism project. You need to advise him as to the hardware and software he will need to invest in. He has seen an advertisement in the local newspaper which he thinks would be perfect for his needs. Answer the questions related to the advertisement listed below:

**Advertisement**

- Intel Dual Core 3.1 GHz
- 2GB RAM
- 500GB Hard drive
- 24" LED Monitor
- QWERTY keyboard and optical mouse
- Integrated LAN and Bluetooth
- DVD-Writer
- Multifunction inkjet printer

Only R5999!
9.1 Mr. Gobig doesn't understand some of the system specifications. Help him to identify the size of each of the following:

9.1.1 The primary output device. (1)
9.1.2 The amount of primary memory. (1)

9.2 The computer is listed as having an integrated LAN adapter.

9.2.1 What does the term integrated mean? (1)
9.2.2 What implication does having an integrated LAN adapter. (1)

9.3 The computer will have Bluetooth available for sending and receiving data. Comment on the advantage of using Bluetooth instead of infrared under each of the following headings:

9.3.1 Speed (1)
9.3.2 Line of sight (1)

9.4 What does the term QWERTY signify with reference to the keyboard? (1)

9.5 The computer will be bought with a high resolution LED monitor.

9.5.1 What does the term resolution mean? (1)
9.5.2 Why should Mr. Gobig insist on buying high resolution monitors? (1)
9.5.3 How would one measure the size and quality of a monitor? (2)

9.6 You have recommended that the computer be bought with 4GB RAM instead of 2GB RAM. Will double the amount of RAM double the speed of the computer? Motivate your answer. (2)

9.7 Name TWO functions that are usually included in a multifunction printer, over and above the fact that it can be used as a printer. (2)

9.8 Mr Gobig would like to invest in a scanner

9.8.1 What is the function of a scanner? (1)
9.8.2 How would he go about to get a printed document on to the computer and edit certain sections without retyping the whole document? (2)
9.8.3 Name TWO disadvantages that Mr Gobig should keep in mind when using a scanner. (2)

9.9 In certain situations it would be a good idea to use biometric input. In each of the following cases recommend a type of biometric input that would be relevant:

9.9.1 Dialing a number in your car while driving. (1)
9.9.2 A situation where a camera / webcam is available. (1)

9.10 Name TWO disadvantages of using biometric features as a security feature. (2)

Mr. Gobig needs to buy software that will be used on the computers. This is an important investment as it would be expensive to replace the software of needed.

9.11 Mr Gobig needs to find out if the software he will be using has any minimum system requirements.

9.11.1 What does the term minimum system requirements mean? (1)
9.11.2 Name TWO examples of system requirements. (2)

9.12 Mr Gobig will have to keep in mind that most software applications will have to be updated from time to time.

9.12.1 What does the term update mean? (1)

9.12.2 Describe the relationship between a version, patch and a service pack. (3)

Mr. Gobig is worried about the security on his network. The network will be used to transfer confidential data that must not be available to other users.

9.13 Usernames and passwords are used on a network to assign user rights. List TWO examples of user rights that may be connected to a username and password. (2)

9.14 In order for the network to be used efficiently, the users will be limited as to what they are allowed to do. These limitations are listed in an acceptable use policy (AUP). Name THREE examples of relevant limitations in an AUP. (3)

9.15 Backups will have to be made of important data.

9.15.1 Why is this important? (1)

9.15.2 Name TWO considerations of making reliable backups. (2)

9.16 Mr Gobig will be having training sessions to train tour leaders in the office. He will need hardware devices such as an interactive whiteboard. Name TWO disadvantages of using an interactive whiteboard. (2)

9.17 Mr Gobig will be using online applications and storage for many purposes. Name TWO advantages of using each. (4)

9.18 To inform future customers of specials in the area for tourists, Mr Gobig will be using a blog.

9.18.1 What is a blog? (1)

9.18.2 Name TWO reasons for using a blog instead of a website. (2)

9.19 What is the function of the POST and the BIOS in the start-up process of a computer? (2)

Total: 150
Question 1 - Word processing

1Brochure

1.1 Fully justify the text in the document. ✓

1.2 ‘World Heritage Sites in South Africa’ inserted:
   • In the header at the beginning of the document. ✓
   • Appears on the first page only. ✓
   • In WordArt size 1.37 cm x 24.6 cm. ✓
   • Filled with picture of SA Flag. ✓

1.3 Automatic table of contents:
   • Appears in the first column under the heading TABLE OF CONTENTS. ✓
   • Page numbers right-aligned. ✓
   • Hyperlinks removed. ✓
   • Only level 1 and level 2 heading styles are displayed. ✓
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1.4 | Picture of Nelson Mandela:  
- Grouped as one object. ✓  
- Correct text wrapping (Square) with text. ✓ |
| 1.5 | *(South Africa Travel, 1999)* is linked to bookmark BIBLIOGRAPHY. ✓ |
| 1.6 | Bulleted list is changed to numbered list (whole document). ✓ |
| 1.7 | T of The (last paragraph - column 3):  
- dropped cap ✓  
- 2 lines. ✓ |
| 1.8 | Automatic page numbering appears from the 2nd page only:  
- In the header. ✓  
- Right aligned. ✓ |
| 1.9 | Page 4 page orientation is landscape. ✓  
All margins are 2.54 cm. ✓ |
| 1.10 | All text from 'Vredefort Dome …' to the end of page 4 in:  
- 3 columns. ✓  
- Vertical line between the columns. ✓ |
| 1.11 | Hyperlink on (http) SAFlag ✓  
Replaced with 1Map. ✓ |
| 1.12 | First column at ‘Select the province …’:  
*Gauteng* and *Free State* ✓  
appear in drop-down list. ✓ |
| 1.13 | 'Current Exchange Rates', starts at the top of second column. ✓ |
| 1.14 | Text converted to a table: ✓  
- Autofit to contents. ✓  
- Appears in the second column. ✓  
- With an orange background colour. ✓ |
| 1.15 | Heading at top of 3rd column *Bookmark and share this information.* ✓  
Image below heading. ✓ |
| 1.16 | Automatic built-in bibliography. ✓  
After the heading 'BIBLIOGRAPHY'. ✓ |
| 1.17 | Endnote changed to footnote. ✓ |
| 1.18 | Light green background colour added to the document. ✓ |

**TOTAL**  [36]
### Question 2 - Word processing

<table>
<thead>
<tr>
<th>2Special</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2.1</strong> The text at bottom of page:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Moved. ✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Appears in a left-aligned sidebar (Alphabet Sidebar). ✓</td>
<td></td>
<td></td>
<td>(3)</td>
</tr>
<tr>
<td>• Sidebar filled with a light green background. ✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>2.2</strong> Date field inserted after DATE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• In the format MM-DD, for example Feb-12. ✓</td>
<td></td>
<td></td>
<td>(2)</td>
</tr>
<tr>
<td>• Updates automatically. ✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>2.3</strong> Check box form field inserted before the word 'English'. ✓</td>
<td></td>
<td></td>
<td>(1)</td>
</tr>
<tr>
<td><strong>2.4</strong> The paper size is A5. ✓</td>
<td></td>
<td></td>
<td>(1)</td>
</tr>
<tr>
<td><strong>2.5</strong> Editing restrictions have been set: ✓✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Allowing the user to fill in the form only. ✓</td>
<td></td>
<td></td>
<td>(3)</td>
</tr>
<tr>
<td><strong>2.6</strong> 2Prem</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>2Members</strong> chosen as merge source. ✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 'Number of years' selected. ✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Years &gt;=5. ✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Sorted in descending order of membership number. ✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Merged fields placed in label: Name, Surname, and Membership number. ✓</td>
<td></td>
<td></td>
<td>(5)</td>
</tr>
<tr>
<td><strong>2.7</strong> Merge saved as <strong>2Merge</strong>. ✓</td>
<td></td>
<td></td>
<td>(1)</td>
</tr>
</tbody>
</table>

**TOTAL** [16]
Theoretical Examination – Paper 2
Memorandum

Marks: 150

Time: 3 hours

Question 1

1.1 A
1.2 D
1.3 A
1.4 C
1.5 C
1.6 B
1.7 A
1.8 D
1.9 B
1.10 A

Question 2

2.1 False, a file attribute of hidden means that the file cannot be edited and saved again✓.
2.2 True✓.
2.3 False, a WLAN is prone to dropping connections✓.
2.4 False, coaxial is usually used to connect an antenna to your television✓.
2.5 True✓.

Question 3

3.1 F
3.2 I
3.3 A
3.4 H
3.5 B
3.6 M
3.7 E
3.8 K
3.9 C
3.10 L

Question 4

4.1 Computers housed within appliances✓, designed for a specific task✓.
4.2.1 A smartphone has more computer features✓.
4.2.2 Any TWO of the following✓:
   * Ability to run 3rd party software
   * Up-to-date operating system such as Android or Symbian
   * Greater processing power than a cell phone
More storage space than a cell phone or a PDA
* Programmability
* E-mail facilities

4.3.1 Touch screen

4.3.2 Any TWO of the following:
* The device can be smaller as no keyboard is needed
* Touch screen use is intuitive
* Keyboard layout can be changed in the screen
* A larger display can be used due to less input devices on the device.

4.4.1 Small programs designed to aid communication between hardware devices and the operating system.

4.4.2 The manufacturer’s website or a 3rd party website.

4.5 Following a set of predefined steps to find and solve a problem.

4.6.1 Check all connections. Check if the correct printer is being used. Check if the correct printer drivers have been installed.

4.6.2 Disconnect the flash drive and reinsert it.

4.7 Input is given via the keyboard and processed by the CPU and RAM. The resulting output is shown on the monitor or saved for future use on the hard drive.

4.8 A client provides resources whereas a client only uses resources. A peer will both provide and use resources.

**Question 5**

5.1 Any TWO of the following:
* Better communications
* Centralised storage
* Easily transfer data
* Easier backup
* Installing and updating software from a central point

5.2.1 Provides Internet access to the network.

5.2.2 The network interface card is the physical connection between the computer and the communications medium.

5.2.3 Prohibiting unauthorised access to or from the network.

5.2.4 A central wiring point in a network where all communication flows through.

5.3.1 Installation cost of a WLAN is much higher than a LAN.

5.3.2 A wired LAN is usually faster than a WLAN.

5.3.3 If not implemented correctly, security on a WLAN is not as good as a LAN.

5.3.4 A WLAN is easier to connect in difficult places than a wired LAN.

**Question 6**

6.1 Data that does not need calculations and is not Date/Time

6.2 Long alphanumeric text, such as a comment

6.3 Numbers used for calculations

6.4 Used for date and time

6.5 Money values

6.6 Used when only one of two values can be selected, such as Yes/No or True/False

6.7 Used to attach an object such as a spreadsheet or picture that will automatically update in the database when the source data changes

6.8 Used to store a link to another file

6.9 Used to attach a file. More than one file can be added

6.10 Numbers automatically added when a new record is entered
**Question 7**

7.1.1 Any TWO of the following:
- * Lower screen resolution for larger icons
- * Use a high contrast theme
- * Changing the thickness/size of the cursor
- * Use visual cues instead of sounds

7.1.2 Any TWO of the following:
- * Sticky keys
- * Assign sounds to keys
- * Keys pressed in rapid succession can be ignored

7.2 A screen magnifier enlarges a section of the screen where the pointer is. A screen reader uses a voice to read out what is happening on the screen.

7.3 Switch of your computer and any peripherals when not in use.

7.4 Any TWO of the following:
- * Use ergonomically designed furniture
- * Take regular breaks
- * Sit comfortably
- * Work in a well lit and ventilated room

**Question 8**

8.1.1 Column is not wide enough. Widen the column or make the font smaller.

8.1.2 Incorrect number used. Correct the data type or number.

8.2.1 Query
8.2.2 Form
8.2.3 Filter

8.3 Validation rule, primary key and input mask.

8.4.1 =E2-D2
8.4.2 =COUNTIF(F2:F11,"<0")

**Question 9**

9.1.1 24 Inch.
9.1.2 4GB.

9.2.1 The adapter is built into the computer, usually within the motherboard.
9.2.2 The computer can be connected to a network without needing to install any extra hardware.

9.3.1 Bluetooth is faster than infrared.
9.3.2 Bluetooth devices do not need to be in line of sight.

9.4 The way the keys are arranged on the keyboard, the first 6 letters.

9.5.1 The amount of pixels that can be displayed on the screen.

9.5.2 Better quality images can be displayed.
9.5.3 Size in inches diagonally across the screen, quality in dpi (resolution).

9.6 No, there are more hardware devices that would influence the speed of the computer such as the CPU, motherboard and hard drive.

9.7 Any TWO of: scanning, photocopying or faxing.

9.8.1 Converting a hard copy of a document or picture to a soft copy.
9.8.2 Scan the document and then convert it to text using an OCR application.
9.8.3 High quality scans take a lot of storage space and you need a high quality scanner to produce high quality scans.

9.9.1 Voice recognition.
9.9.2 Facial recognition.
9.10 Any TWO of the following:

* A flu can affect your voice
* Users that do not have hands will not be able to use fingerprint scanners

9.11.1 The minimum software and hardware combination needed to run an application.
9.11.2 Minimum amount of RAM and open hard drive space.
9.12.1 Installing new programming code to improve the application.
9.12.2 After improving and adding to an application the developer will release a new updated program which is known as the new version. Versions are indicated by v1.1 or v1.2. Patches are small pieces of code developed to correct errors in a program that users can download and install. A service pack is a collection of patches and updates over a period of time that are released and packaged as one unit.

9.13 Any TWO of the following:

* Preventing or allowing access to certain files and folders.
* Prohibiting access to certain applications
* Blocking access to certain websites or the Internet as a whole
* Preventing users to make changes to system settings

9.14 Any THREE valid limitations within an AUP, such as:

* Do not access information that is not yours.
* Do not steal hardware
* Do not try to bypass security measures
* Do not install unlicensed software
* Scan devices for viruses before use

9.15.1 In a case where the original data is lost or corrupted the backup data can be used.

9.15.2 Any TWO of the following:

* Use reliable storage methods
* Make more than one backup copy
* Store in a safe place

9.16 Any TWO of the following:

* Expensive to buy
* Steep learning curve for new users
* New users will not be able to intuitively use it
* Not suitable when large amounts of data need to be entered

9.17 Two each of the following:

Any TWO advantages of an online application:

* In many cases it is free to us
* Do not have to install it on your computer
* Can access your application and work from any computer

Any TWO advantages of online storage:

* Data can be accessed from anywhere in the world.
* Storage on your own computer is not used
* Files can be shared easily with a link
* Data can be retrieved immediately without inserting storage devices

9.18.1 A personal online diary.

9.18.2 Any TWO of the following:

* Easy to update by the author
* Easy to follow new news as the newest post is at the top
* Easier to create than a website

9.19 The POST (Power on self test) checks power supply to all components. The BIOS contains system settings such as date, time and hardware device information of hard drives, RAM, etc.